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Ievads 1
Kas ir šaj  noda
• P rskats: lappuse 1
• Pal dz ba: lappuse 3
• Atbalst t s ier ces: lappuse 3 
• K  lietot šo rokasgr matu: lappuse 5
• Lietot ja droš ba: lappuse 6

P rskats

Pateicamies, ka izv l j ties Medtronic Diabetes par savu partneri, kas 
pal dz s Jums un J su pacientiem lab k vad t savu diab ta rst šanu.

M s uzskat m, ka jaun ko CareLink™ Pro programm šanas sasniegumu 
un vienk ršas ar izv lni darbin mas lietot ja saskarnes izmantošana 
dos Jums labumu.

Šaj  lietot ja rokasgr mat  aprakst ts, k  lietot CareLink Pro, ieg t, 
uzglab t un pazi ot pacienta rst šanas un diagnostikas datus. Taj
aprakst ta ar  piek uves opcija s knim, m r t jam un sensora dotiem 

glikozes datiem, kurus J su pacienti augšupiel d s CareLink™ Personal
t kla rst šanas vad bas sist m , kas darbojas ar CareLink Pro.
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Iesp jas     

CareLink Pro ir diab ta rst šanas vad bas programmat ra person liem 
datoriem (PC). Tai ir š das paz mes:

• Var izveidot pacienta ierakstus, kuros glab t no pacienta ier ces 
ieg tos datus un rst šanas datus no vi a CareLink Personal konta. 

• Insul na s k u, monitoru un glikozes l me a asin s m r t ju datus var 
nos t t uz sist mu, uzglab t un p c tam izmantot zi ojumu ener šanai.

• Opcion li tai ir saskarne ar CareLink Personal sist mu, kas auj piek t
ier ces datiem, kurus pacienti ir taj  saglab juši. Tas noder, lai 
izveidotu aktu lus zi ojumus starp iest des apmekl jumiem, t d
vairs nav nepieciešams nolas t ier ces datus apmekl juma laik .

• No pacienta ierakstos saglab tajiem ier ces datiem var izveidot daž du
rst šanas procesu zi ojumus. Zi ojumi pal dz atrast atbildes uz 
rst šanas problem tiskiem jaut jumiem, piem ram, par to, k

pacients iev ro noteikumus, par mode iem un iz mumiem.
• Sist ma br dina, kad ir pieejami programmat ras jaunin jumi 

lejupl d šanai un instal šanai. T d  Jums ir pieejamas jaun k s
sist mas iesp jas.

• Ir pieejama iesp ja Guide Me (Vadi mani), kas pal dz jauniem 
CareLink Pro lietot jiem. Taj  ir padomi par izpild majiem 
uzdevumiem.

• Vis  programmat r  ir integr ta pal dz bas sist ma, kas sniedz 
inform ciju par interes još m jom m.

Droš ba     

• CareLink Pro var aizsarg t ar paroli.
• Pacienta datu p rs t šana no CareLink Personal ir šifr ta ar 

komercstandarta Secure Sockets Layer (SSL) tehnolo iju.

Saist tie dokumenti     

Visos šajos Medtronic MiniMed dokumentos ir ier cei specifiska 
inform cija, kas nav s ki izkl st ta šaj  lietot ja rokasgr mat .

PIEZ ME: Par citu
komp niju m r t jiem

skat t m r t jiem
pievienot s ražot ja

instrukcijas.

• Paradigm insul na s k a lietot ja rokasgr mata
• Guardian REAL-laika monitora lietot ja rokasgr mata
• Sensora iesp ju lietot ja rokasgr mata
• ComLink lietot ja rokasgr mata
• CareLink USB lietot ja rokasgr mata
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Pal dz ba

Ja Jums nepieciešama papildu pal dz ba š s sist mas lietošanai, l dzu,
sazinieties ar viet jo p rst vi. Starptautisk  kontaktinform cija atrodama 
š d  vietr d  URL:

http://www.medtronicdiabetes.com/help/contact/locations.html

PIEZ ME: Dažas ier ces,
ko atbalsta š

programmat ra, var
neb t pieejamas vis s

valst s, kur s š
programmat ra ir

apstiprin ta lietošanai.

Atbalst t s ier ces

CareLink Pro sa em datus no š d m ier c m.           

Insul na s k i/glikozes monitori 

Medtronic MiniMed s k i 508

Medtronic MiniMed Paradigm 
s rijas s k i

511, 512, 712, 515, 715, 522, 722, 522K, 
722K, Paradigm® REAL-Time Revel™
(523, 723, 523K, 723K),  
Paradigm® Veo™ (554, 754)  

Guardian REAL-Time monitors CSS-7100
CSS-7100K

Ražot js Glikozes l me a asin s m r t ji     

Medtronic diab ta
partneru ier ces:

• Bayer CONTOUR® LINK
• LifeScan OneTouch® UltraLink™

• BD Paradigm Link® glikozes l me a
asin s monitors

LifeScan:

• OneTouch® UltraSmart®

• OneTouch® Profile®

• OneTouch® Ultra®

• OneTouch® Basic®

• OneTouch® FastTake®

• OneTouch® SureStep®

• OneTouch® Ultra® 2
• OneTouch® UltraMini™

• OneTouch® UltraEasy®

Bayer:
• BREEZE™

• BREEZE™ 2
• CONTOUR®
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BD: • Logic®

Bayer Ascensia® DEX®

saime, ietverot š dus 
sader gus m r t jus:

• Ascensia® DEX®

• Ascensia® DEX® 2 
• Ascensia® DEXTER-Z® II
• Glucometer® DEXTER-Z®

• Ascensia® ESPRIT® 2 
• Glucometer® ESPRIT®

• Glucometer® ESPRIT® 2

Bayer Ascensia ELITE™

saime, ietverot š dus 
sader gus m r t jus:

• Ascensia ELITE™

• Glucometer ELITE® XL 

Abbott

• Precision Xtra™

• TheraSense FreeStyle®, FreeStyle Flash™

• FreeStyle Papillion™ Mini 
• FreeStyle Mini
• Optium Xceed™

• Precision Xceed™

Roche

• Accu-Chek® Aviva
• Accu-Chek® CompactPlus
• Accu-Chek® Compact
• Accu-Chek® Active

Komunik cijas ier ces                 

 Com-Station
lietošanai ar MiniMed 508 s kni. (S k ku
inform ciju par nepieciešamo aparat ru
skat t Com-Station lietot ja rokasgr mat .)

ComLink

lietošanai ar MiniMed Paradigm s kni un 
Guardian REAL-Time monitoru. (S k ku
inform ciju par nepieciešamo aparat ru
skat t ComLink lietot ja rokasgr mat .)

Paradigm Link® glikozes l me a
asin s monitors

lietošanai ar MiniMed Paradigm s kni un 
Guardian REAL-Time monitoru. (S k ku
inform ciju par nepieciešamo aparat ru
skat t Paradigm Link® glikozes monitora 
lietot ja rokasgr mat .)

CareLink™ USB
lietošanai ar MiniMed Paradigm s kni 
un Guardian REAL-Time monitoru.

Datu p rraides kabe i
lietošanai ar trešo personu glikozes l me a
asin s m r t jiem. Katrs m r t ja ražot js
pieg d  datu p rraides kabeli.

Ražot js Glikozes l me a asin s m r t ji     
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Ekvivalent s ier ces       

Lai pievienotu ier ci sist mai, sarakst  j izv las t s izgatavot js un 
modelis. Ja ier ces izgatavot ja un mode a nav sarakst , mekl jiet 
n kamaj  tabul  ekvivalentu v lamajam.

PIEZ ME: M r t jus var
pas t t attiec gaj s

komp nij s.

Pas t šana                       

Lai pas t tu Medtronic diab ta izstr d jumus, sazinieties ar viet jo
p rst vi. Medtronic starptautisk  kontaktinform cija atrodama š d
vietr d  URL:

http://www.medtronicdiabetes.com/help/contact/locations.html

K  lietot šo rokasgr matu

Terminu un funkciju defin cijas lasiet V rdn c . Šaj  rokasgr mat
lietotie nosac jumi ir defin ti n kamaj  tabul .

Šaj  lietot ja rokasgr mat  ir par d ti programmat ras ekr nu paraugi. 
Faktiski lietot s programmat ras ekr ni var nedaudz atš irties.

Ja j su pacients lieto k du no š m ier c m Izv lieties šo ier ci

• Bayer’s Ascensia® DEX®

• Bayer’s Ascensia® DEX® 2
• Bayer’s Ascensia® DEXTER-Z® II
• Bayer’s Glucometer® DEXTER-Z®

• Bayer’s Ascensia® ESPRIT® 2 
• Bayer’s Glucometer® ESPRIT®

• Bayer’s Glucometer® ESPRIT® 2

Bayer’s Ascensia® DEX®

Bayer’s Glucometer ELITE® XL Bayer’s Ascensia ELITE™ XL 

Precision Xceed™ Optium Xceed™

Termins/stils Noz me

Klikš is lai izv l tos objektu, uz t  j noklikš ina ar peles 
kreiso pogu 

Dubultklikš is lai atv rtu objektu, uz objekta ekr n  divreiz 
j noklikš ina ar peles kreiso pogu

Lab s pogas klikš is lai par d tu citu logu vai izv lni, uz objekta ekr n
j noklikš ina ar peles labo pogu

Treknraksta teksts
lietots izv lnes opcij m un izv lnes ce am. 
Piem ram: Patient > New Patient
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Lietot ja droš ba

Lietošanas indik cijas 

CareLink Pro sist ma paredz ta k  r ks, kas pal dz rst t diab tu. 
Š sist ma paredz ta inform cijas sa emšanai no insul na s k iem,
glikozes l me a m r t jiem un glikozes nep rtrauktas nov rošanas
sist m m un t s izmantošanai CareLink Pro zi ojumu sast d šan .
Zi ojumi sniedz inform ciju, p c kuras var identific t tendences 
un izsekot ikdienas aktivit t m, piem ram, og hidr tu pat ri am,

dienreižu laikiem, insul na padevei un glikozes r d jumiem. 

Br din jumi

• Sist ma paredz ta lietošanai vesel bas apr pes speci listiem,
kuri p rzina diab ta rst šanu. 

• Sist mas rezult ti nav paredz ti medic niskas konsult cijas 
sniegšanai, un tos nedr kst izmantot š dam nol kam. 

• Šo izstr d jumu vajadz tu lietot vien gi kop  ar šaj  dokument
nosaukt m atbalst taj m ier c m. (Skat t Atbalst t s ier ces, 
lappus 3.)

• Pacientiem j iesaka kontrol t savu glikozes l meni asin s vismaz 
4–6 reizes dien .

• Pacientiem j nor da, ka tiem nevajadz tu main t rst šanas rež mu,
nekonsult joties ar vesel bas apr pes speci listu.

• Pacientiem j iesaka pie emt l mumu par rst šanu, pamatojoties uz 
vesel bas apr pes speci lista ieteikumiem un m r t ja BG rezult tiem,
nevis uz glikozes sensora rezult tiem.

Teksts ar LIELIEM 
BURTIEM apz m  pogu. Piem ram: SAVE

Teksts sl prakst izmanto ekr nu un lauku nosaukumos. Piem ram:
Reports ekr ns

PIEZ ME: papildu inform cija

UZMAN BU! br dina par briesm m, kas, ja netiek nov rstas, var 
izrais t nelielus vai m renus programmat ras vai 
aparat ras boj jumus.

BR DIN JUMS: br dina par iesp jam m briesm m, kas, ja netiek 
nov rstas, var izrais t n vi vai nopietnus ievainojumus. 
Taj  var b t aprakst tas ar  iesp jam s nopietn s
nev lam s blakuspar d bas un droš bas apdraud jumi.

Termins/stils Noz me
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Kontrindik cijas 

Šo programmat ru nevajadz tu lietot ier c s, kas nav nosauktas 
Atbalst t s ier ces, lappus 3. Šo izstr d jumu ar  nevar izmantot 
citu vesel bas probl mu rst šanai, iz emot diab tu.

Pirms š s progrqammas atv ršanas aizveriet visas p r j s
programmas, kas pašreiz darbojas j su dator :

• CGMS® System Solutions™ programma 

• Solutions® Pumps & Meters programma 

• Guardian® Solutions® programma 

• ParadigmPAL™

• CareLink™ Personal 

• Solutions® Software for CGMS® iPro
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Sist mas navig cija 2
Kas ir šaj  noda
• P rskats: lappuse 8
• CareLink Pro atv ršana: lappuse 8
• Darbtelpas: lappuse 10
• Galven s izv lnes josla: lappuse 12
• R kjosla: lappuse 12
• Guide Me iesp ja: lappuse 13
• Iepaz stieties vair k ar sait m: lappuse 14
• Pal dz bas sist ma: lappuse 14

P rskats

Šaj  noda  var iepaz ties ar CareLink™ Pro grafisko lietot ja saskarni (GUI). 
Lietot ja saskarn  ir izv lnes, r kjosla, navig cijas josla, darbtelpas un 
Guide Me (vadi mani) logs. 

CareLink Pro atv ršana

1 Veiciet sava datora darbvirsm  dubultklikš i uz CareLink Pro ikonas.

Ja J su slimn ca prasa ievad t paroli, par d s pieteikšan s ekr ns.

a. Ievadiet savu paroli Password lauk .

 CareLink Pro
darbvirsmas ikona
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PIEZ ME: Paroles
pras šana ir izv les

iesp ja, kas tiek
iestat ta instal šanas

proces .

b. Klikš iniet uz LOGIN (pieteikties).

Par d s start šanas ekr ns.

2 Lai s ktu jaunu pacienta ierakstu, klikš iniet uz NEW PATIENTS. Lai 
atv rtu sist mas pacientu sarakst  esoša pacienta ierakstu, klikš iniet 
uz OPEN PATIENT.

        

galven s izv lnes

akt v
darbtelpa

piek uve pacientu 
sarakstam

pievienot jaunu
pacientu

navig cijas josla

statusa josla

Zi ojumu
darbtelpas poga

Ier u darbtelpas
poga

Profila darbtelpas
poga

par d t/pasl pt Guide Me logu
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Darbtelpas

PIEZ ME: S k ku
inform ciju par

darbtelp m un to
lietošanu lasiet š s

lietot ja rokasgr matas
cit s noda s.

Ja pacienta ieraksts ir atv rts, var noklikš in t uz vienas no navig cijas
joslas pog m, lai par d tos atbilstoš  darbtelpa. Izmantojiet š s darbtelpas, lai 
ievad tu vai atlas tu inform ciju, kas nepieciešama, lai veiktu 
CareLink Pro uzdevumus šim pacientam.

• Profils: auj saglab t t du pacienta inform ciju k  v rdu un dzimšanas 
datumu. Šaj  darbtelp  iesp jams ar  saist ties ar pacienta CareLink 
Personal kontu.

• Ier ces: auj saglab t inform ciju, kas nepieciešama, lai veiktu pacienta 
ier u nolas jumus.

• Zi ojumi: auj izv l ties parametrus un izv l ties, k dus zi ojumus 
pacientam ener t.

Kam r pacientam nav pievienots un saglab ts profils, šim pacientam 
pieejama vien gi Profile darbtelpa. Kam r pacientam nav pievienotas 
ier ces, šim pacientam pieejamas vien gi Profile un Devices darbtelpas.
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Darbtelpas

Ier u darbtelpa

Profila darbtelpa

Zi ojumu darbtelpa

Profils

Ier ces

Zi ojumi
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Galven s izv lnes josla

Turpm k par d tas galvenaj  izv ln  pieejam s opcijas. Daž m no š m
izv lnes opcij m var piek t ar , izmantojot tastat ras sin jumikonas, 
kas nor d tas blakus izv lnes opcijai (piem., Ctrl+N jaunam pacientam). 
Daž m izv lnes opcij m var piek t ar , izmantojot navig cijas joslu un 
r kjoslu.

R kjosla

CareLink Pro r kjosla auj tri piek t bieži lietot m iesp j m. R kjoslai 
ir š das pogas.

Pogas Nosaukums Funkcionalit te

Add Patient Atver Profile darbtelpu, aujot sist m
pievienot jaunu pacienta ierakstu.

Open Patient
Atver pacienta p rl ktabulu, kur  var 
izv l ties un apskat t esošu pacienta 
ierakstu.

Guide Me
Par da un pasl pj Guide Me logu. 
Klikš iniet, lai ieg tu sist mas ieteikumus 
konteksta izpratnei. 
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Pacienta cilnes

Kad ir atv rts pacienta ieraksts, r kjosl  par d s cilne ar pacienta 
v rdu. Kad cilne ir akt va, ar  pacienta ieraksts un darbtelpa ir akt va,
t d  iesp jams veikt CareLink Pro uzdevumus pacientam.

Pacienta ierakstu var aktiviz t, vienk rši uzklikš inot uz vi a cilnes. 
Lai ierakstu aizv rtu, klikš iniet uz pacienta cilnes pogas CLOSE.

Guide Me iesp ja

Guide Me iesp ja tiek nodrošin ta ar CareLink Pro. T  atver logu 
ar kontekst  saprotamiem padomiem un ieteikumiem par darb b m,
kuras iesp jams veikt akt vaj  sist mas da . Guide Me logos var b t
iek autas ar >> learn more saites. Ja uz t m noklikš ina, t s atver 
tiešsaistes pal dz bas atbilstoš s sada as ar s k ku inform ciju. Guide 
Me iesp ja ir akt va p c noklus juma. Ta u to jebkur  laik  var atsl gt.

CLOSE 
poga

neakt va cilne akt va cilne

Aizv ršanas poga
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Guide Me iesl gšana un izsl gšana 

Pogas opcija

• Lai iesl gtu vai izsl gtu Guide Me, noklikš iniet uz GUIDE ME pogas.

Izv lnes opcija

• Lai izv l tos iesp ju vai to atceltu, atlasiet Help > Guide Me.

Iepaz stieties vair k ar sait m

Iesp ja Learn More links (iepaz stieties vair k ar sait m) auj piek t
sist mas tiešsaistes pal dz bas tematiem. Tos nodrošina sist ma
Guide Me logos vai programmat r . Ja nezin t, k  turpin t darbu vai 
k das v rt bas ievad t, noklikš iniet uz >> learn more.

Pal dz bas sist ma

Pal dz bas sist ma ir pieejama, lai sniegtu pal dz bu, kad J s lietojat 
CareLink Pro. T  sniedz inform ciju par to, k  izpild t uzdevumus ar 
programmu. 

Lai piek tu pal dz bas sist mai, veiciet k du no š d m darb b m:

• Izv lieties Help > Medtronic CareLink Pro Help.
• Nospiediet F1 pogu.

Guide Me poga

learn more link
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S kšana 3
Kas ir šaj  noda
• Pirms s kšanas: lappuse 15
• Pacientu ierakstu atv ršana un aizv ršana: lappuse 17
• Sist mas priorit šu iestat šana: lappuse 18 

Šaj  noda  ir instrukcijas, kas j izpilda, start jot CareLink™ Pro
programmat ru, atverot un aizverot pacientu ierakstus un nosakot 
priorit tes, ko sist ma piem ros visiem pacientiem. 

Pirms s kšanas

Ja J s pirmo reizi lietojat CareLink Pro, j iestata visp r jas priorit tes
(skat t Visp r jas priorit tes, lappus 18). Š s priorit tes nosaka, k
noteiktas lietas tiek atveidotas programm tiski un zi ojumos un k
sist ma komunic s ar internetu.

Priorit tes var iestat t jebkur  laik . J s varat pagaid t, l dz apg stat 
CareLink Pro programmat ru, pirms iestat t citas priorit tes.
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Sist mas galvenie uzdevumi

N kamaj  tabul  izkl st ti galvenie uzdevumi, kas b tu j veic, pirmo 
reizi uzst dot un lietojot CareLink Pro. Taj  ar  nor d ts, kur  š s lietot ja 
rokasgr matas da  ir apskat ts katrs uzdevums.

Solis Vieta

Iepaz stieties ar CareLink Pro lietot ja 
saskarni. Noda a 2, Sist mas navig cija

Defin jiet slimn c  lietojam s kop j s
sist mas opcijas.

Sist mas priorit šu iestat šana, 
lappus 18

Izveidojiet katram pacientam profilu. Jaunu profilu pievienošana, 
lappus 25

Sasaistieties ar pacientu 
CareLink Personal kontiem.

Saist šana ar CareLink Personal 
(fakultat va), lappus 26

Pievienojiet pacienta profilam pacienta 
s kni un m r t jus. Ier ces pievienošana, lappus 35

Nolasiet pacienta s k a un m r t ju 
r d jumus. Ier ces datu nolas šana, lappus 41

Sast diet un ener jiet katram 
pacientam zi ojumus.

Zi ojumu izveidošana, lappus 44

Regul ri izveidojiet CareLink Pro 
datub zes dubl jumu.

Datub zes dubl šana, lappus 56

Aktualiz jiet CareLink Pro programmu.
Programmat ras jaunin jumu 
instal šana, lappus 55
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Pacientu ierakstu atv ršana un aizv ršana

Pacienta ierakstu atv ršana         

Vienlaic gi var atv rt l dz sešiem pacienta ierakstiem. Ja v l neviens 
pacienta profils v l nav izveidots, skat t Jaunu profilu pievienošana, 
lappus 25.

1 Izv lieties File > Open Patient vai klikš iniet uz OPEN PATIENT 
pogas. Par d sies pacientu saraksts, kas l dz gs t l k redzamajam.

PIEZ ME: Ja sa emat
pazi ojumu, ka atv rts

p r k daudz pacientu
ierakstu, noklikš iniet

uz OK, aizveriet ierakstu
un turpiniet.

2 Atrodiet pacientu sarakst , ierakstot pacienta v rda da u vai visu 
v rdu Find a Patient lauk . Kad pacienta ierakstu uzskait jums tiek 
izcelts, noklikš iniet uz OPEN, veiciet dubultklikš i uz uzskait juma 
vai nospiediet ENTER. P rvietoties sarakst  var ar  ar tastat ras
augšup jo un lejup jo bulttausti u.

Tiek par d ta pacienta Devices (ja ier ces v l nav pievienotas) vai 
Reports darbtelpa.

3 Lai redz tu pacienta Profile darbtelpu, klikš iniet uz navig cijas joslas 
PROFILE pogas.

Pacienta ierakstu aizv ršana        

1 P rliecinieties, vai pacienta ieraksts, kuru v laties aizv rt, ir akt vs 
(cilne izcelta).

2 Veiciet vienu no š d m darb b m:

a. Izv lieties File > Close Patient.
b. Klikš iniet uz pacienta cilnes pogas CLOSE.
c. Nospiediet Ctrl+F4.

Open Patient
poga

Profila poga

aizv ršanas poga
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Sist mas priorit šu iestat šana

Sist ma piem ro š s priorit tes visiem pacientiem. Par katram 
pacientam individu l m priorit t m skat t Zi ojuma iestat jumu 
p rbaude, lappus 47.

Priorit tes tiek par d tas š d s grup s:

• Visp r jas

– Glikozes vien bas
– Og hidr tu vien bas
– Komunik cijas
– Trauc jummekl šana

• Pacienta profils

– Izv lieties un izk rtojiet pacientu profilu datu laukus.
• Pacienta inform cijas atrašana

– Modific jiet un mainiet lauku par d šanas sec bu, kad izv laties 
Open Patient, lai skat tu pacientu sarakstu.

• Zi ojuma ener šana

– Izv lieties datu laukus, kurus v laties redz t, kad datu tabul
izv l sieties Daily Detail zi ojuma ievadi.

Visp r jas priorit tes

1 Izv lieties Tools > Options. Par d s š ds logs.
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2 Ar klikš i izv lieties t s v rt bas opciju pogu, kas jums nepieciešama:

– Glikozes vien bas: mg/dl vai mmol/l
– Og hidr tu vien bas: grami vai apmai as
a. Ja Carbohydrate Units izv laties apmai as, ierakstiet piem rotu

skaitli gramos, kas ekvivalents 1 apmai as laukam.

3 Lai izv l tos š das komunik cijas, ieklikš iniet kontrollodzi
(iesp jot) vai atceliet izv li, v lreiz ieklikš inot (atiesp jot):

PIEZ ME: Iestatot
komunik cijas

priorit tes, iev rojiet
savas slimn cas vai IT

departamenta
ieteikumus.

– Programmat ras aktu lo versiju autom tiska p rbaude: ja
t ir izv l ta, ikreiz, kad b s pieejama programmat ras aktualiz t
versija, tiks nos t ts pazi ojums katrai sist mai, kur  darbojas 
CareLink Pro. Tad akt vajam lietot jam b s iesp ja lejupl d t un 
instal t aktualiz t s versijas. Lai tas nenotiktu un b tu iesp ja
kontrol ti izplat t programmat ras aktu l s versijas, š  kontrollodzi a
izv le j atce .

– Sinhroniz t ar CareLink™ Personal: ja v laties, lai sist ma 
autom tiski sinhroniz  pacienta CareLink Personal datus ikreiz, 
kad tiek atv rts vi a profils, atz m jiet kontrollodzi u Synchronize 
with CareLink Personal. Ja š  kontrollodzi a izv le tiek atcelta, 
CareLink Personal dati katram pacientam b s j sinhroniz  manu li.

4 Kontrollodzi u var izv l ties vai izv li atcelt sada  Trauc jummekl šana.
Ja kontrollodzi š ir atz m ts, lietojumprogramma saglab s ier ces r d jumu
ierakstus trauc jummekl šanas vajadz b m.

5 Lai saglab tu visp r j s priorit tes, klikš iniet uz OK. 
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Pacienta profila priorit tes         

1 Izv lieties Tools > Options.

2 Klikš iniet uz Patient Profile cilnes. Par d s š ds logs.

Datu lauku izv l šan s

1 Ar kontrollodzi iem pievienojiet v lamos laukus.

PIEZ ME: V rdu un
uzv rdu nevar iz emt.

2 Lauka iz emšanu no profila veic ar kontrollodzi a izv les atcelšanu.

3 Lai lauku apz m tu k  nepieciešamo, atz m jiet kontrollodzi u
Required slej . Nepieciešamais lauks j aizpilda pirms profila 
izveidošanas.

Individu lu lauku pievienošana         

1 Atz m jiet kontrollodzi u pa kreisi no tukša individu l  lauka.

2 Ievadiet lauka nosaukumu (piem., sazi a rk rtas apst k os). 
Ar š du nosaukumu šis lauks par d sies pacienta profil .

3 Lai lauku apz m tu k  nepieciešamo, atz m jiet kontrollodzi u
Required slej .

Ar kontrollodzi iem izv lieties tos laukus, kurus v laties šaj  profil . Laukus v lamaj
sec b  novietojiet ar augšup j m un lejup j m bulti m.
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PIEZ ME: Lai iz emtu
individu lo lauku no

profila, atceliet
kontrollodzi a izv li,

kas atrodas blakus
iz emajamam laukam.

Datu lauku sec bas mai a         

• Izv lieties p rvietoajmo lauku un, lai to p rvietotu, klikš iniet lejup jo
vai augšup jo bulti u. (Augšpuses un apakšpuses bulti as p rvieto lauku 
no saraksta augšas uz leju vai otr di.) 

Pacienta profila priorit šu noform šana        

• Kad lauku sarakst  visi nepieciešamie lauki ir pareiz  sec b ,
klikš iniet uz OK.

Tagad pacienta profil  izv l tie lauki ir v lamaj  sec b .

Pacienta inform cijas atrašanas priorit tes       

1 Izv lieties Tools > Options.

2 Klikš iniet uz Patient Lookup cilnes. Par d s  š ds logs.

Par d mo datu izv l šan s

• Lai izv l tos datu veidu, ko v laties par d t pacienta inform cijas
atrašanas tabul , izmantojiet kontrollodzi us.

Up & Down
 bulti as

Ar kontrollodzi iem izv lieties tos datus, kurus v laties pacienta inform cijas atrašanas
tabul . Slejas v lamaj  sec b  novietojiet ar augšup j m un lejup j m bulti m.
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PIEZ ME: V rdu un
uzv rdu nevar iz emt.

Sleju sec bas mai a

• Lai pacienta inform cijas atrašanas tabul  main tu sleju sec bu, izv lieties
p rvietojamo sleju un klikš iniet uz augšup j m un lejup j m bulti m.
(Augšpuses un apakšpuses bulti as p rvieto datu sleju no saraksta 
augšas uz leju vai otr di.)

PIEZ ME: Sleju
r d šanas sec bas

augšpus  esoš  datu
sleja tiks par d ta

pacienta inform cijas
atrašanas tabulas

pirmaj  slej . Apakš
esoš  datu sleja tiks

par d ta tabulas p d j
slej .

Pacienta inform cijas atrašanas priorit šu noform šana       

• Kad sleju par d šanas sec bas sarakst  visi nepieciešamie dati ir 
pareiz  sec b , klikš iniet uz OK.

Tagad pacienta inform cijas atrašanas tabul  ir izv l tie dati un 
sleju sec ba.

Zi ojuma ener šanas priorit tes

Zi ojuma ener šanas procesa izv les da  tiek par d ta datu tabula. 
Šaj  tabul  j b t datiem, ko vesel bas apr pes speci lists uzskata par 
visnoder g kajiem, lai izlemtu, k dos datumos vi š v las redz t Daily 
Detail (ikdienas detaliz ta inform cija) zi ojumus.

PIEZ ME: Lai redz tu, k
š s priorit tes zi ojuma

izveidošanas proces
tiek piem rotas datu

tabulai, skat t Zi ojuma
veida un iek aujamo

datumu izv le,
lappus 49.

1 Izv lieties Tools > Options.

2 Klikš iniet uz Report Generation cilnes. Par d s š ds logs.

Up & Down
 bulti as

Ar kontrollodzi iem izv lieties to datu veidu, kuru v laties datu tabul . Slejas v lamaj
sec b  novietojiet ar augšup j m un lejup j m bulti m.
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Par d mo datu izv l šan s        

• Lai izv l tos datu veidu, ko v laties par d t datu tabul  vai dz st no 
tabulas, izmantojiet kontrollodzi us.

Sleju sec bas mai a        

• Lai datu tabul  main tu sleju sec bu, izv lieties p rvietojamo sleju 
un klikš iniet uz augšup j m un lejup j m bulti m. (Augšpuses un 
apakšpuses bulti as p rvieto datu sleju no saraksta augšas uz leju 
vai otr di.)

PIEZ ME: Sleju sec bas
saraksta augšpus
esošie ieraksti tiks

par d ti datu tabulas
pirmaj  slej . Apakš

esošie ieraksti tiks
par d ti datu tabulas

p d j  slej .

Zi ojuma ener šanas priorit šu noform šana         

• Kad sleju sec bas sarakst  visi nepieciešamie dati ir pareiz  sec b ,
klikš iniet uz OK. 

Tagad datu tabul  ir izv l tie dati un sleju sec ba.

Up & Down
 bulti as
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Profila darbtelpa 4
Kas ir šaj  noda
• Pirms s kšanas: lappuse 24
• Jaunu profilu pievienošana: lappuse 25
• Pacienta profilu redi šana: lappuse 25
• Pacienta datu dz šana no sist mas: lappuse 25
• Saist šana ar CareLink Personal (fakultat va): lappuse 26

Profils ir l dz gs medic nisk s kartes titullapai. Taj  ir t di dati par 
pacientu k  v rds un dzimšanas datums. Profils j izveido, pirms 
s kt v kt ier ces datus un izmantot tos rst šanas zi ojumos.

Profila darbtelp  iesp jams ar  izveidot saiti uz pacienta CareLink 
Personal kontu. Kol dz saite ir izveidota, jebkur  laik  iesp jams
nolas t CareLink Personal saglab tos pacienta datus, un nav 
nepieciešama pacienta kl tb tne.

Pirms s kšanas

Var b t nepieciešams piel got pacientu profilus t , ka tie satur tikai tos 
datus, ko j s v laties sav kt. Vair k las t Pacienta profila priorit tes, 
lappus 20.

Kad tiek izveidota saite uz pacienta CareLink Personal kontu, nepieciešams 
ar  lietot ja v rds un parole. Šie dati ieg stami pacienta kl tb tn .
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Jaunu profilu pievienošana

Katru reizi, kad tiek pievienots pacients CareLink Pro sist mai, j s k
ar pacienta profila aizpild šanu. 

1 Izv lieties File > New Patient vai klikš iniet uz ADD PATIENT pogas. 

Tiek par d ta Profile darbtelpa (piem ru skat t lappuse 11).

PIEZ ME:Lai pacienta
profil  pievienotu vai

main tu laukus,
klikš iniet

>> customize fields.
Skat t Pacienta profila
priorit tes, lappus 20.

2 Aizpildiet laukus Patient Profile sada .

3 Klikš iniet uz SAVE.

Jauns pacienta profils ir pievienots CareLink Pro datub zei. Tiek par d ts
pazi ojums, kas apstiprina, ka profils ir saglab ts.

Ja, saglab jot pacienta profilu, nepieciešamie lauki  nav aizpild ti, blakus 
attiec gajam laukam par d s pazi ojums. Profilu nav iesp jams saglab t, 
kam r laukos nav ierakstu.

Pacienta profilu redi šana

1 P rliecinieties, ka pacienta Profile darbtelpa ir atv rta.

2 Klikš iniet uz EDIT.

3 Redi jiet datus Patient Profile sada  p c vajadz bas.

4 Klikš iniet uz SAVE.

Tiek par d ts pazi ojums, kas apstiprina, ka profils ir saglab ts.

Pacienta datu dz šana no sist mas

1 P rliecinieties, ka pacienta Profile darbtelpa ir atv rta.

2 P rliecinieties, ka šis ir pacients, kuru v laties dz st. Pacienta profila 
dz šana iz em no CareLink Pro datub zes ar  visus vi a datus, un 
tos vairs nevar atg t.

3 Klikš iniet uz >> delete patient record virs profila sinhroniz cijas
sada as.

Par d s br din juma pazi ojums, ka dz šot ierakstu, tiks izdz sti 
visi pacienta dati. 

4 Lai izdz stu pacienta ierakstu, klikš iniet uz YES.

Add Patient
poga
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Saist šana ar CareLink Personal (fakultat va)

Ja pacients at auj, j s varat izveidot saiti uz vi a CareLink Personal 
kontu. Šis t kla r ks auj pacientiem augšupl d t un uzglab t ier ces
sniegtos datus, k  ar  veidot daž dus rst šanas zi ojumus. 

Tikl dz jums ir saite uz pacienta CareLink Personal kontu, j s varat 
nolas t datus, kas saglab ti pacienta ier c , lai tos izmantotu CareLink Pro 
zi ojumu ener šanai. Zi ojumus var ener t jebkur  laik , pat 
ambulatoro apmekl jumu starplaikos. T d  ar  nav nepieciešams 
nolas t pacienta ier ces r d jumus viz tes laik .

Ja pacientam v l nav CareLink Personal konta, var vi am nos t t
e-pastu, mudinot t du izveidot. 

Saites uz esošu konta  

PIEZ ME: Šie so i ir
izpild mi pacienta

kl tb tn .

1 P rliecinieties, ka ir savienojums ar internetu.

2 Atveriet pacienta Profile darbtelpu. 

3 P rliecinieties, ka visi nepieciešamie lauki Patient Profile sada
ir aizpild ti.

4 Klikš iniet uz LINK TO EXISTING ACCOUNT. 

Par d s CareLink Personal Log In ekr ns.

5 Lieciet, lai pacients izdara sekojošo:

a. Ieraksta savu lietot ja v rdu un paroli.
b. Noklikš ina uz SIGN IN. 

Tiek par d ta piek uves pieš iršanas lapa, pamatojoties uz pacienta 
re istr cijas valodas un re iona iestat jumiem.
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6 Lieciet, lai pacients izdara sekojošo:

a. Izlasa lietošanas nosac jumus.
b. Ieklikš ina lodzi  blakus I agree to the Terms of Use above…
c. Klikš ina uz GRANT ACCESS.
d. Gaida, kam r par d s Thank You (paldies) lapa.
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Noklikš inot uz PRINT pogas, ir iesp jams izdruk t lietošanas nosac jumus, 
lai iedotu tos pacientam.

Tagad jums ir saite uz pacienta CareLink Personal kontu. Skat t Datu
ieg šana no piesaist t  konta, lappus 29.

E-pasta uzaicin juma s t šana           

Lai nos t tu pacientam e-pasta uzaicin jumu izveidot CareLink 
Personal kontu, veiciet š dus so us:

1 Atveriet pacienta Profile darbtelpu. 

2 P rliecinieties, ka visi nepieciešamie lauki Patient Profile sada
ir aizpild ti.

3 Klikš iniet uz SEND E-MAIL INVITATION TO PATIENT.

4 P rliecinieties, ka Patient Name, Email un Language… ir pareizi aizpild ti.

5 Klikš iniet uz SEND. 

Pacienta profila statusa zon  par d s e-pasta nos t šanas apstiprin jums.

Pacienta CareLink Personal konta atsaist šana no CareLink Pro

Pacienta CareLink Personal kontu var atsaist t no CareLink Pro. Š
opcija ir pieejama vien gi tad, ja pacients bijis piesaist ts. Tas p rtrauc 
CareLink Pro datu nolas šanu no pacienta CareLink Personal konta. 
Tas netrauc  pacientam pašam lietot savu CareLink Personal kontu. 

1 Atveriet pacienta ierakstu un piek stiet Profile darbtelpai.

2 Klikš iniet uz UNLINK ACCOUNT.
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3 Apstiprin juma pazi ojum  klikš iniet uz Yes. Pacienta personiskais 
profils vairs nav saist ts ar CareLink Pro.

Statuss main s uz “Nesaist ts” un par d s LINK TO EXISTING 
ACCOUNT un SEND E-MAIL INVITATION TO PATIENT pogas.

Datu ieg šana no piesaist t  konta            

Ja jums ir saite uz pacienta CareLink Personal kontu, jaunie dati no t  tiek 
s t ti autom tiski ikreiz, kad j s atverat pacienta profilu CareLink Pro. 

PIEZ ME: Lai tas
notiktu, ejiet uz Tools >

Options > General un
p rliecinieties, ka

blakus “Synchronize
with Medtronic CareLink

Personal” ir atz m ts
kontrollodzi š.

Lai ieg tu pacienta CareLink Personal datus, veiciet šos so us ikreiz 
p c tam, kad esat atv ris pacienta profilu:

1 P rliecinieties, ka pacienta Profile darbtelpa ir atv rta un jums 
ir savienojums ar internetu.

2 Izv lieties Tools > Synchronize Patient Data.

Sinhroniz cijas ikona pacienta ciln  griežas. Kad ikona apst jas, 
process ir pabeigts.

PIEZ ME: Ja pacients
vairs nev las,

dal ties ar saviem
CareLink Personal

datiem, šo funkciju var
izsl gt izv ln

OPTIONS. Par d sies
pazi ojums, kas par to

inform s.

3 Visi papildu dati, kas ieg ti no CareLink Personal, par d sies pacienta 
zi ojumos. 

sync (sinhroniz cijas)
ikona
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Aparat ras uzst d šana 5
Kas ir šaj  noda
• Pirms s kšanas: lappuse 30
• Savienošanas ier ces: lappuse 31

Šaj  noda  ir z m jumi, kas r da, k  uzst d t pacienta ier ci, lai dators 
var nolas t ier ces datus.

Jums nepieciešama pacienta ier ce, lai tieši no t s nolas tu datus. Bet 

ier ces datus var nolas t ar  no pacienta CareLink™ Personal konta, nevis 
no pašas ier ces.   

Pirms s kšanas

Lai nolas tu datus tieši no ier ces, jums j b t pieejamai pacienta ier cei
un visiem kabe iem vai komunik cijas ier c m, kas nepieciešamas, lai 
p rs t tu datus uz datoru.
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Savienošanas ier ces

PIEZ ME: S k ku
inform ciju lasiet

instrukcij s, ko par da
CareLink™ Pro, kad tiek

nolas ta ier ce.

Apskatiet kop jo z m jumu, lai g tu visp r gu ieskatu, k  j uzst da ier ces, 
lai t s komunic tu ar datoru. Z m jumos att lotas ar  atseviš as ier u
komunik ciju deta as. 

PIEZ ME: Šaj  z m jum
par d ts CareLink USB,

caur kuru komunic
s knis un dators.

P rskats par aparat ras uzst d šanu               

TM

CareLinkUSB

CareLink USB

PC

Paradigm s knis
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Aparat ras savienojumu z m jumi                                    

                      

PC savienojumi

USB
piesl gvieta

Seri l
piesl gvieta



CareLink™ Pro lietot ja rokasgr mata    Aparat ras uzst d šana      33

pievienot PC seri lai
piesl gvietai

ComLink lietošanai ar Paradigm s rijas s kni

Papildu sast vda as

Com-Station lietošanai ar MiniMed 508 s k iem un m r t ja datu p rraidei
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Ier u darbtelpa 6
Kas ir šaj  noda
• Pirms s kšanas: lappuse 35
• Ier ces pievienošana: lappuse 35
• Ier ces aktiv šana un inaktiv šana: lappuse 40 
• Ier ces datu nolas šana: lappuse 41

Nepieciešam  inform cija, lai nolas tu pacienta ier ci (izgatavot js, modelis, 
s rijas numurs u.c.) tiek glab ta Devices darbtelp . T d  t  nav j ievada 
ikreiz, kad nolas t ier ces datus. 

Ier ces Devices darbtelp  tiek glab tas vien  no diviem sarakstiem –
Active Devices (Akt v s ier ces) vai Inactive Devices (Neakt v s ier ces).
Kad ier ce tiek pievienota, t  autom tiski tiek ievietota Active Devices
sarakst . Datus var nolas t vien gi no sarakst Active Devices par d taj m
ier c m. T s, visticam k, b s ier ces, ko pacients lieto pašreiz. 

Citas pacientam piederoš s ier ces, kas pašlaik netiek lietotas, var 
glab t sarakst Inactive Devices. Tas saglab  inform ciju fail . Š s
ier ces var aktiviz t jebkur  laik .
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Pirms s kšanas

Pirms ir iesp jams atv rt pacienta Devices darbtelpu, vi am ir j b t
sist m  saglab tam profilam. Skat t Noda a 4, Profila darbtelpa.

Lai ier ci pievienotu vai nolas tu datus no t s tieši, ier cei j b t komunik cij
ar datoru. Par ier u uzst d šanu, lai t s komunic tu ar datoru, lasiet 
Noda a 5, Aparat ras uzst d šana.

Ier ces pievienošana

Ir iesp jams ieg t datus no pacienta CareLink Personal konta ier cei,
kas v l nav pievienota. Š das ier ces tiks autom tiski pievienotas, 
kad tiks sinhroniz ti dati starp CareLink Personal un CareLink Pro.

PIEZ ME: Vienam
pacientam akt vs var

b t tikai viens s knis.
Jauna s k a

pievienošana esošo
s kni p rvietos uz
neakt vo sarakstu.

Medtronic s k a vai Guardian monitora pievienošana          

1 P rliecinieties, ka ier ce, kuru j s pievienojat, ir uzst d ta
komunik cijai ar datoru. (Par savienošanas so iem skat t Noda a 5, 
Aparat ras uzst d šana.)

2 Klikš iniet uz pacienta cilnes vai veiciet dubultklikš i uz pacienta 
v rda Pacienta inform cijas atrašanas tabul .

3 Klikš iniet uz DEVICES, lai piek tu pacienta Devices darbtelpai 
(skat t piem ru lappuse 11).

4 Klikš iniet uz ADD DEVICE.

5 Izv lieties Medtronic Pump/Guardian. Tiek par d ts Add Medtronic 
Pump/Guardian vednis.

DEVICES poga
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PIEZ ME: S k a
modelis ir nor d ts uz
s k a aizmugures vai

par d s s k a statusa
ekr n .

6 Lai nor d tu pievienojamo ier ci, izv lieties opciju pogu. 

Ja esat izv l jies MiniMed 508 pump opciju, ejiet uz 9. soli.

7 Klikš iniet uz NEXT. Par d s Serial Number lapa.

PIEZ ME: Ja netiek
ievad ts pareizais

s rijas numurs, par d s
k das pazi ojums.

P rbaudiet šaj  lap
esošos piem rus un

p rliecinieties, ka esat
ierakst jis pareiz s

rakstz mes, kas
redzamas s k a

aizmugur . Ja
nepieciešams, no jauna

uzrakstiet sešas
rakstz mes.

8 Izmantojiet š s lapas piem rus, kas pal dz atrast pievienojam s
ier ces sešz mju s rijas numuru. (Ja t  atrašanai nepieciešama 
papildu pal dz ba, klikš iniet uz >> learn more). Ievadiet sešas 
rakstz mes Device Serial Number lauk .

9 Klikš iniet uz NEXT. Par d sies Communication Options lapa, 
kas ir l dz ga turpm k par d tajai.

10 Klikš iniet uz Choose Port nolaižam s izv lnes un izv lieties 

piesl gvietu, caur kuru savienot ComLink, Paradigm Link®,
CareLink USB vai Com-Station ar datoru. Ja nezin t, kuru 
piesl gvietu izv l ties, izv lieties Auto Detect (jeb USB).
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11 Klikš iniet uz NEXT. Par d sies Test Connection lapa, kas ir l dz ga 
turpm k par d tajai.

12 R kojieties p c ier ces instrukcijas un klikš iniet uz TEST.

Par d sies pazi ojums, kas inform s, ja savienojums b s izveidots. 
Ja t  notiek, ejiet uz n kamo soli. 

PIEZ ME: Šaj  test
netiek nolas ti s k a

dati, bet tiek p rbaud ta
komunik cija starp

s kni un datoru.

Ja t  nenotiek, p rbaudiet, vai aparat ra starp ier ci un datoru ir pareizi 
savienota. Klikš iniet ar  uz ved a lap m BACK, lai p rbaud tu, ka 
esat pareizi ievad jis ier ces datus.

13 Klikš iniet uz DONE.

S knis ir pievienots pacienta Active Devices sarakstam.
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M r t ja pievienošana            

1 Klikš iniet uz pacienta cilnes vai veiciet dubultklikš i uz pacienta 
v rda Pacienta inform cijas atrašanas tabul .

2 P rliecinieties, ka m r t js, kuru j s pievienojat, komunic  ar datoru. 
(Par savienošanas so iem skat t Noda a 5, Aparat ras uzst d šana.)

3 Klikš iniet uz DEVICES, lai piek tu pacienta Devices darbtelpai 
(skat t piem ru lappuse 11).

4 Klikš iniet uz ADD DEVICE pogas.

5 Izv lieties Blood Glucose Meter. Tiek par d ts Add Blood Glucose 
Meter vednis.

6 Lai izv l tos pareizo m r t ja modeli, klikš iniet uz opciju pogas.

7 Klikš iniet uz NEXT. Tiek par d ta Meter Model lapa (š  lapa var b t
atš ir ga daž diem m r t ju ražot jiem).

8 Klikš iniet uz m r t ja mode a, kuru pievienojat. 
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9 Klikš iniet uz NEXT. Par d s Communication Options lapa.

PIEZ ME: Pievienošanai
atlas t var tikai tos

m r t jus, kas ir
apstiprin ti.

10 Klikš iniet uz Choose Port nolaižam s izv lnes un izv lieties 

piesl gvietu, caur kuru savienot ComLink, Paradigm Link® vai 
CareLink USB ar datoru. Ja nezin t, kuru piesl gvietu izv l ties,
izv lieties Auto Detect.

11 Klikš iniet uz NEXT. Par d s Test Connection lapa.

12 R kojieties atbilstoši konkr t  m r t ja instrukcijai, p c tam klikš iniet 
uz TEST.

Par d sies pazi ojums, kas inform s, ja savienojums b s izveidots. 
Ja t  notiek, ejiet uz n kamo soli. 

Ja t  nenotiek, p rbaudiet, vai aparat ra starp ier ci un datoru ir pareizi 
savienota. Klikš iniet ar  uz BACK vedn , lai p rbaud tu, vai esat pareizi 
ievad jis datus.

13 Klikš iniet uz DONE.

M r t js ir pievienots pacienta Active Devices sarakstam.
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Ier ces aktiv šana un inaktiv šana

Pacienta ier ces var p rvietot starp Active Devices sarakstu un Inactive 
Devices sarakstu p c vajadz bas. Lai no ier ces nolas tu datus, tai j b t akt vai. 

Active Devices sarakst  var b t tik daudz m r t ju, cik v laties, bet 
tikai viens s knis. Pirms jauna s k a pievienošanas p rliecinieties,
ka pašreiz jais s knis ir neakt vs.

Ier ces inaktiv šana              

1 Klikš iniet uz pacienta cilnes vai veiciet dubultklikš i uz pacienta 
v rda Pacienta inform cijas atrašanas tabul .

2 Klikš iniet uz DEVICES, lai piek tu pacienta Devices darbtelpai.

PIEZ ME: Ier ces var b t
ierakst tas ar

ekvivalentas ier ces
nosaukumu. Skat t

Ekvivalent s ier ces,
lappus 5.

3 Klikš iniet uz t s ier ces >> make this device inactive, kuru v laties 
padar t neakt vu (inaktiv t).

Ier ce tiek p rvietota uz Inactive Devices sarakstu.

Ier ces reaktiv šana               

1 Klikš iniet uz pacienta cilnes vai veiciet dubultklikš i uz pacienta 
v rda Pacienta inform cijas atrašanas tabul .

2 Klikš iniet uz DEVICES. Par d s pacienta Devices darbtelpa.

3 Klikš iniet uz t s ier ces >> activate this device, kuru v laties aktiv t.

Ier ce tiek p rvietota uz Active Devices sarakstu.

Ier ces dz šana             

Ar šiem so iem izdz š ier ci un t s datus no Devices darbtelpas un 
no CareLink Pro sist mas:

1 Klikš iniet uz pacienta cilnes vai veiciet dubultklikš i uz pacienta 
v rda Pacienta inform cijas atrašanas tabul .

2 Klikš iniet uz DEVICES, lai piek tu pacienta Devices darbtelpai.
3 P rliecinieties, ka ier ce ir Inactive Devices sarakst . Ja nav, 

klikš iniet uz >> Inactivate this device t s pašreiz j  sarakst .
4 Klikš iniet uz t s ier ces >> delete this device, kuru v laties dz st.

Par d s br din juma pazi ojums, ka ier ce un visi t s dati tiks iz emti 
no pacienta ieraksta.

5 Lai izdz stu ier ci, klikš iniet uz YES. 

Ier ce un t s dati tiek iz emti no Devices darbtelpas un CareLink Pro 
sist mas. Š s ier ces datus vairs nevar izmantot zi ojumiem.
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Ier ces datu nolas šana

Viens veids, k  ieg t ier ces datus, ir piesl gties esošam pacienta 
CareLink Personal kontam. (Skat t Saist šana ar CareLink Personal 
(fakultat va), lappus 26.) Cits veids ir tieša nolas šana no pacienta 
ier ces, k  aprakst ts šaj  noda .

Datus no j su pacienta ier ces var nolas t ar CareLink Pro, ja ier ce ir 
Active Devices sarakst  un komunik cij  ar datoru. Tikl dz dati ir ieg ti, 
tos var izmantot zi ojumu sast d šanai, kas pal dz nov rt t pacienta 

rst šanas vad bu. (Par zi ojumiem vair k las t Noda a 7, Zi ojumu 
darbtelpa.)

Augšupiel des laik  CareLink Pro sist ma ieg st no insul na s k a
š da veida inform ciju:  

• daž dus s k a iestat jumus, piem ram, trauksmes rež mu, p kstiena 
ska umu un laika r d jumu;

• pieg d to pamata insul na daudzumu;
• bolus notikumus un ievad to daudzumu;
• Bolus Wizard ierakstus;
• inici šanas daudzumu;
• aptur šanas laikposmus;
• sensora glikozes r d jumus laikposm , s k iem ar sensora paš b m.

Sist ma var ieg t datus ar  no Guardian REAL-Time sist mas, tostarp:

• sensora glikozes (SG) r d jumus;
• sensora koeficienta v rt bas;
• sensora kalibr šanas koeficientus;
• dienreižu mar ierus;
• insul na injekcijas.

Turkl t ier ces r d jumu nolas šanas laik  sist m  var augšupiel d t
daž du inform ciju, kas saglab ta asins glikozes m r t j .

BR DIN JUMS: L dzu, atceliet vai pabeidziet visas slaic g s pamata vai akt v s bolus 
pieg des un izt riet akt vos trauksmes sign lus. Nolas šanas laik  s knis tiks aptur ts.
Tikl dz nolas šana ir pabeigta, l dzu, p rbaudiet, vai s k a darb ba ir atjaunota.

UZMAN BU! S k a datu nolas šanas laik  nelietojiet s k a t lvad bas pulti. 

Ja s k a baterija ir iztukšojusies, s knis nes t s datus uz PC. Ja statusa r d jums liecina, 
ka baterij  ir maz ener ijas, nomainiet bateriju.    
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1 Klikš iniet uz pacienta cilnes vai veiciet dubultklikš i uz pacienta 
v rda Pacienta inform cijas atrašanas tabul .

2 P rliecinieties, ka ier ce komunic  ar datoru. (Skat t Noda a 5, 
Aparat ras uzst d šana.)

3 Klikš iniet uz DEVICES, lai piek tu pacienta Devices darbtelpai.

PIEZ ME: Ier ces var b t
ierakst tas ar

ekvivalentas ier ces
nosaukumu. Skat t

Ekvivalent s ier ces,
lappus 5.

4 Atrodiet ier ci Active Devices sarakst , no kuras v laties ieg t datus, 
un p rliecinieties, ka Choose port dati ir pareizi.

– S k iem klikš iniet uz Amount of Data nolaižam s izv lnes un 
izv lieties, cik daudz s k a datu v laties, lai CareLink Pro nolasa.

5 Klikš iniet uz saist t s READ DEVICE pogas.

6 R kojieties p c ier ces instrukcijas un klikš iniet uz OK.

7 CareLink Pro par da norises joslu, kas atjaunin s, lai par d tu,
cik daudz ier ces r d jumu jau nolas ts.

8 Ja ier ces nolas šanas laik  noklikš in siet uz CANCEL, par d sies 
br din juma pazi ojums, darb bas atcelšana var novest pie jau 
nolas to datu zuduma. Lai ats ktu augšupiel di, j noklikš ina uz 
READ DEVICE pogas (solis 5).

– Lai atceltu, klikš iniet uz YES. 
– Lai turpin tu las t ier ces datus, klikš iniet uz NO.

Kad sist ma pabeidz ier ces datu nolas šanu, t  ats t s pazi ojumu,
kas apstiprina, ka ier ce ir piln b  nolas ta.

9 Klikš iniet uz OK. 

– S k iem iev rojiet instrukcijas par to izvešanu no aptur šanas 
rež ma.

Ja CareLink Pro nesp j ieg t datus no ier ces, papildu ieteikumus lasiet 
Noda a 9, Trauc jummekl šana.
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Zi ojumu darbtelpa 7
Kas ir šaj  noda
• Pirms s kšanas: lappuse 43
• Zi ojumu izveidošana: lappuse 44
• Par zi ojumiem: lappuse 51
• Datu eksport šana: lappuse 52

CareLink™ Pro zi ojumu darbtelp  var p rveidot no ier ces ieg tos 
datus kl niski der g  inform cij . Par zi ojumu veidiem, ko var 
sast d t, las t Par zi ojumiem, lappus 51.

Zi ojumus var ener t uz ekr na, s t t tieši uz druk šanas ier ci vai 
saglab t k  TIFF vai PDF failus, kurus var pievienot 
elektroniskajam medic niskajam ierakstam (EMR). Ar vienu darb bu 
var ener t vair kus zi ojumu veidus.

Šajos zi ojumos par d tie dati ir ieg ti no pacienta ier c m, vi a
CareLink Personal konta vai abiem. 

Pirms s kšanas

Ja jums ir zin ms laikposms, kuru v laties atspogu ot zi ojumos, 
j b t ar  pacienta ier u datiem par šo laikposmu. Var b t
nepieciešama ar  pacienta ier u savienošana ar datoru, lai pirms 
zi ojumu veidošanas ieg tu aktu los datus.

Pirms zi ojuma sast d šanas uzman gi izlasiet Verify Report 
Settings. Šaj  viet  var prec zi iestat t zi ojumu, lai tas atlas tu jums 
nepieciešamos pacienta datus.
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Zi ojumu izveidošana

Turpm kaj s noda s aprakst ti viena vai vair ku zi ojumu 
izveidošanas so i.

Zi ojumu darbtelpas atv ršana      

1 Noklikš iniet uz pacienta cilnes vai OPEN PATIENT pogas un veiciet 
dubultklikš i uz pacienta v rda.

Tiek par d ta Reports darbtelpa (piem ru skat t lappuse 11).

PIEZ ME: Lai
p rliecin tos, ka j su

r c b  ir jaun kie ier ces
dati no pacienta

CareLink Personal
konta, klikš iniet uz

SYNC DATA.

Zi ojuma laikposma izv le        

1 Lai main tu laikposmu, kura atspogu ojumu v laties ietvert 
zi ojum (os), klikš iniet uz Duration nolaižam s izv lnes un 
izv lieties posma ilgumu. (Maksim lais ilgums ir 12 ned as.)

2 S kuma un beigu datums tiek iestat ts autom tiski, ja nav izv l ta 
custom date range opcija. 

PIEZ ME: Ja
izv l sieties gar ku

laikposmu nek  at auts,
sa emsiet k das

pazi ojumu. Kori jiet
ilgumu vai datumus.

Ja v laties savu datumu diapazonu, klikš iniet uz From vai Through
nolaižamaj m izv ln m un izv lieties nepieciešamo m nesi, datumu 
vai gadu. 

Datu kalend rs

Darbtelpas Reports datu kalend ra zon  tiek r d ts logs ar zi ojuma 
inform ciju par tr s m nešiem. Taj  ir nosauktas ier ces un tiek 
par d ts, cik daudz ier ces datu ieg ts izv l tajos tr s m nešos. Tiek 
par d ts ar  zi ojuma laikposma ilgums izv l tajos tr s m nešos.

Ja ier ces datu un zi ojuma laikposmi p rkl jas, jums ir dati par k du
vai visiem par d tajiem zi ojuma laikposmiem.

Open Patient
poga

ier ces dati
zi ojuma laikposms

datu kalend rs
m neši
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S kum  datu kalend ra zon  tiek par d ti p d jie tr s m neši. Lai 
redz tu citus m nešu, klikš iniet bulti u pogas uz attiec g  m neša 
s kuma vai beig m.

Iek aujamo pirmdatu izv le       

1 Ja pacients lieto BG m r t ju, kas savienots ar s kni, m r t ja BG 
datu zi ošanai ar klikš i izv lieties vienu no š d m opcij m:

– s kn : š s izv les priekšroc ba ir t da, ka jums j nolasa vien gi 
pacienta s k a dati, BG r d jumiem datumu pieš ir s knis, un 
r d jumi ir tieši sasaist ti ar jekburu izmantoto Bolus Wizard 
apr inu. Tr kums ir t ds, ka, ja rodas k das probl mas 
komunik cij  starp s kni un piesaist to m r t ju, BG r d jumi par 
problem tisko laikposmu netiks zi oti. Ar  MiniMed Paradigm 
s k iem, kas vec ki par 522/722, Bolus Wizard apr inu BG 
r d jumi, kas nav izsekoti, netiks zi oti.

– piesaist taj (os) m r t j (os): š s izv les priekšroc ba ir t da, ka 
visi piesaist taj  m r t j  saglab tie r d jumi tiks zi oti. Tr kums ir 
t ds, ka, lai korel tu m r t ja un s k a datus, j p rliecin s, ka 
s k a un m r t ja pulkste i ir savstarp ji sinhroniz ti. Var ar
nolas t s k a datus un piesaist t  m r t ja datus atseviš i.

2 Lai pievienotu ier ces datus zi ojumiem, atz m jiet kontrollodzi u
blakus attiec gajai ier cei. 

Nevar pievienot ier ces, kas nebija izv l tas 1. sol . Lai to main tu, 
izv lieties cita piesaist t  m r t ja opciju.

3 Lai izsl gtu ier ces datus no zi ojumiem, atceliet kontrollodzi a atz mi
blakus attiec gajai ier cei. 

Nevar atcelt opciju atz mes, kas bija izv l tas 1. sol . Lai to main tu,
izv lieties cita piesaist t  m r t ja opciju.

Ier ces datu un zi ojuma laikposma 
p rkl jums

bulti u pogas
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Ier ces datu p rbaud šana        

1 Lai redz tu, vai zi ojuma laikposms p rkl jas ar ier ces datiem, 
skatieties Reports darbtelpas datu kalend ra zon  (skat t piem ru
lappuse 45).

2 Ja joslas p rkl jas vis  zi ojuma laikposm , dati zi ojumam(iem) ir 
pietiekami. Var klikš in t uz NEXT un iet uz Zi ojuma iestat jumu 
p rbaude, lappus 47.

3 Ja joslas nep rkl jas vai p rkl jas da ji, ir vair kas iesp jas:

– Kori t zi ojuma laikposmu (skat t Zi ojuma laikposma izv le,
lappus 44).

– Ieg t ier ces papildu datus (skat t Ier ces papildu datu ieg šana, 
lappus 46).

Ier ces papildu datu ieg šana         

1 Lai ieg tu vair k ier ces datu, klikš iniet uz attiec g s ier ces READ 
DEVICE pogas.

Tiek par d ta Read Device josla.

BR DIN JUMS: L dzu, atceliet vai pabeidziet visas slaic g s pamata vai akt v s bolus 
pieg des un  izt riet akt vos trauksmes sign lus. Nolas šanas laik  s knis tiks aptur ts.
Tikl dz nolas šana ir pabeigta, l dzu, p rbaudiet, vai s k a darb ba ir atjaunota.

UZMAN BU! S k a datu nolas šanas laik  nelietojiet s k a t lvad bas pulti. 

Ja s k a baterija ir iztukšojusies, s knis nes t s datus uz PC. Ja ier ces statusa ekr ns
r da, ka baterij  ir maz ener ijas, nomainiet bateriju.    

2 P rbaudiet, vai dati Choose port lauk  atbilst šai ier cei. 

Lai main tu šo iestat jumu, klikš iniet uz š  lauka nolaižam s izv lnes
un izv lieties citu iestat jumu.

3 P rliecinieties, ka ier ce ir savienota ar datoru. 

READ DEVICE josla

READ DEVICE poga
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4 Ja š  ier ce ir s knis, var nor d t, cik daudz datu no t s j ieg st.
Klikš iniet uz Amount of Data nolaižam s izv lnes un izv lieties 
daudzumu.

PIEZ ME: Ja
izv l sieties All available

data, sist ma nolas s
visus datus

s kn . T d  veid  tiek
no jauna p rrakst ti

sist m  esošie
dubl juma dati.

5 Klikš iniet uz READ DEVICE. Uzman gi izlasiet par d to pazi ojumu,
jo taj  ir konkr tas instrukcijas s k a datu nolas šanai.

6 R kojieties p c instrukcijas un klikš iniet uz OK. 

Tiek par d ta ier ces nolas šanas virz bas josla.

Nolas šanu var atcelt jebkur  laik , klikš inot uz CANCEL.

Par d s pazi ojums, kas apstiprina, ka nolas šana ir pabeigta.

7 Klikš iniet uz OK.

Tagad datu kalend r  par d s ier ces dati.

8 Klikš iniet uz NEXT Reports darbtelpas augšpus .

Tiek par d ts Verify Report Settings solis. Taj  pirms zi ojuma(u) 
sast d šanas var p rliecin ties, vai iestat jumi konkr tajam pacientam 
ir pareizi.

Zi ojuma iestat jumu p rbaude           

1 P rliecinieties, ka Glucose Target iestat jumiem ir nor d tas 
vajadz g s v rt bas. Ierakstiet š s v rt bas vai, lai palielin tu vai 
pazemin tu v rt bas, klikš iniet uz augšup j m un lejup j m bulti m
Low un High laukos.

laika ass

dienreize

lauki dienreižu laikposmu redi šanai

miega un nomoda laikposmi
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PIEZ ME: Var b t l dz
piec m dienreiz m.

P c noklus juma ir
brokastis, pusdienas un

vakari as.

2 Lai pievienotu jaunu dienreizes laikposmu, klikš iniet uz ADD MEAL. 
Lai redi tu esošu dienreizes laikposmu, klikš iniet jebkur uz laika 
ass jebkuras dienreizes laikposm .

dienreižu laikposma redaktors, kas atrodas zem laika ass, k st
akt vs.

3 Lai atlas tu v lamos iestat jumus, ievadiet tekstu vai klikš iniet uz 
bulti m.

PIEZ ME: Ja v laties
šos iestat jumus
izmantot tikai šai

dienreizei, atceliet
kontrollodzi a atz mi

blakus Use these
parameters for all of this

patient’s meals.

– Meal Name: ierakstiet nosaukumu, kuru v laties pieš irt šim 
dienreizes laikposmam.

– Meal Time Period: stundas starp dienreižu laikiem.
– Pre-Meal BG Target (mg/dL or mmol/L): pacienta glikozes m r a

diapazona zem k s un augst k s v rt bas pirms šanas.
– Pre-Meal Analysis Period: laikposms, kur  glikoze tiks analiz ta

pirms dienreizes s kuma. Šaj  laikposm  ieg tie glikozes 
r d jumi tiks izmantoti detaliz tai zi ojuma anal zei.

– Post-Meal BG Target (mg/dL or mmol/L): pacienta glikozes 
m r a diapazona zem k s un augst k s v rt bas p c šanas.

– Post-Meal Analysis Period: laikposms, kur  glikoze tiks analiz ta
p c dienreizes. Šaj  laikposm  ieg tie glikozes r d jumi tiks izmantoti 
detaliz tai zi ojuma anal zei.

PIEZ ME: dienreižu
laikposmi nevar

p rkl ties, ta u s kuma
un beigu punkti var

robežoties viens ar otru.
dienreižu laikposmiem

j b t vismaz 60 min tes
ilgiem.

Esoša dienreizes laikposma ilgumu, nomoda un miega periodu var 
main t, klikš inot uz s kuma vai beigu tura, velkot to pa laika asi un 
atlaižot. 

izv lieties s kuma vai beigu turi, velciet to pa laika asi un atlaidiet

laika ass

m r t ja nolas šanas mar ieri
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4 Lai izmantotu š s dienreizes iestat jumus cit m pacienta 
dienreiz m, atz m jiet kontrollodzi u blakus Use these parameters 

for all of this patient’s meals.

5 P c dienreizes laikposma izveidošanas vai redi šanas 
pabeigšanas klikš iniet uz SAVE.

6 Lai iz emtu dienreizes laikposmu, klikš iniet uz DELETE MEAL. 
Kad tiek pras ts apstiprin jums, klikš iniet uz DELETE.

7 CareLink Pro var atcer ties š  pacienta iestat jumus n kamaj  reiz ,
kad sast d siet zi ojumu šim pacientam. Lai tos saglab tu šim 
pacientam, klikš iniet uz SAVE SETTINGS.

8 Klikš iniet uz NEXT Reports darbtelpas augšpus .

Šis ir procesa Select and Generate Reports solis. Taj  tiek sniegts 
zi ojumu veidu saraksts, bet datu tabula pal dz izv l ties dienas
detaliz taj  zi ojum (os) iek aujam s vai izsl dzam s datu dienas. 

9 Lai izdruk tu ekr na r d jumus, klikš iniet uz PRINT ikonas.

PIEZ ME: Lai modific tu
datu tabulas r d šanu,

klikš iniet uz
>>customize columns.

Skat t Zi ojuma
ener šanas priorit tes,

lappus 22.

Zi ojuma veida un iek aujamo datumu izv le           

1 Atz m jiet kontrollodzi u blakus zi ojuma(iem), ko v laties iek aut 
zi ojumu komplekt .

2 Ja zi ojuma laikposm  s k a vai Guardian monitora dati nolas ti 
vair kas reizes, var par d ties vair ki ier ces momentuz mumi: 

a. P rliecinieties, ka kontrollodzi š blakus Device Settings Snapshot
ir atz m ts.

Datu tabula

druk
as

ikona
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b. Klikš iniet uz nolaist s bulti as un izv lieties momentuz muma
datumu un laiku. 

– S k i: izv lieties momentuz mumu no pacienta s k a.
– Guardian: izv lieties momentuz mumu no pacienta Guardian 

monitora.

Ja k ds lauks ir bl vs, zi ojuma laikposm  momentuz mumi nav 
pieejami.

3 Lai p rskat tu dienas detaliz t  zi ojuma inform ciju, ritiniet cauri datu 
tabulai.

– Katras slejas datus var š irot. Lai datus sak rtotu augšupejoš
sec b , klikš iniet uz slejas nosaukuma. Lai datus sak rtotu
lejupejoš  sec b , v lreiz noklikš iniet uz slejas nosaukuma.

PIEZ ME: Ja konkr taj
datum  nav datu, šo

datumu izv l ties nevar.

4 Atz m jiet kontrollodzi us taj s datu tabulas rind s, kura datuma 
datus v laties redz t dienas detaliz taj zi ojum .

– Lai ar vienu klikš i iek autu dienas detaliz taj  zi ojum  visus 
datumus vai izsl gtu tos no zi ojuma, atz m jiet kontrollodzi u
datu tabulas kontrollodzi u slejas augšpus .

Zi ojumu ener šana                                  

1 Kad ir p rbaud tas zi ojuma izv les, klikš iniet uz GENERATE 
REPORTS darbtelpas Reports augšpus .

Par d s opciju saraksts.

2 Izv lieties zi ojuma(u) priekšskat juma, druk šanas vai saglab šanas
opciju.

Ja izv laties Preview, par d s Report Preview logs.

3 Lai š irst tu daudzlappušu zi ojumus, klikš iniet uz bulti u pog m.

4 Lai saglab tu vai izdruk tu zi ojumu(s), klikš iniet uz cit m pog m
Report Preview loga augšpus .

5 Lai šo logu aizv rtu, noklikš iniet uz CLOSE pogas loga augš j
labaj  st r .CLOSE preview

poga
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Par zi ojumiem         

Šaj  noda  sniegti visu zi ojumu apraksti. Vair k inform cijas par 
zi ojuma sast vda m un paraugzi ojumus var skat t zi ojumu 
rokasgr mat . Zi ojumu rokasgr matai var piek t CareLink Pro 
programm :

1 Help > View Report Reference Guide (PDF).

2 Izv lieties zi ojumu rokasgr matas valodu.

CareLink Pro zi ojumiem ir š di kop ji elementi: 

• Report header — zi ojuma galvene satur identifik cijas inform ciju, 
piem ram, zi ojuma nosaukumu, pacienta v rdu un datu avotu.

• Carbohydrates and blood glucose levels — Grafikos un 
diagramm s og hidr tu vien bas par d tas sl prakst , bet asins 
glikozes l me i treknrakst .

• Weekend data — ned as nogales dienas ir treknrakst , t d  t s ir 
viegli identific t.

• Legends — simbolu skaidrojumi par d s katra zi ojuma apakšpus .
Lai gan simbolus var izmantot daudzos zi ojumus, skaidrojumi ir 
unik li katram zi ojumam.

Noteikumu iev rošanas zi ojums        

Šaj  zi ojum  tiek atspogu ots, k  insul na s k i un sensori ir lietoti, un 
pacienta uzved ba saist b  ar noz m to rst šanu. Tas sniedz atbildi 
uz jaut jumu "Vai bija pietiekami daudz datu, lai sniegtu prec zu
pacienta r c bas ainu, lietojot insul na s kni un sensoru, ja t ds bija 
lietojams?" Tas sniedz ar  atbildi uz jaut jumu "Vai pacients iev ro 
noteiktos rst šanas noteikumus?" Tas ar  nor da, vai jums vajadz tu 
p rrun t ar pacientu, k  vi š p rvalda savu diab tu.

Sensora un m r t ja p rskata zi ojums        

Sensora un m r t ja p rskata zi ojum  ir pacienta m r t ja ik dienas 
noteikto glikozes l me u un vid jo lielumu grafisks att lojums, ietverot 
sadal jumu pa stund m 24 stundu garum , un šo datu korel cija ar 

dienreiz m un miega rež mu. Ir iek auta ar  statistika par pacienta 
glikozes r d jumiem un insul na pat ri u. 

Ja tiek lietots sensors, l dz ga sensora datu anal ze tiek ener ta k  š
zi ojuma pirm  lapa. Ja sensora dati nav pieejami, k  pirm  lapa tiks 

ener ta m r t ja datu anal ze.
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Zi ojuma nosl guma lapa(s) r da, k  pacients kontrol  glikozes, 
og hidr tu un insul na pat ri u pa dien m. Katr  lap  par d ts, k
kontrole main s dienas laik  vis  zi ojuma laikposm , ietverot vien
lap  l dz 14 dienu r d jumus.

Ierakstu žurn la zi ojums        

Ierakstu žurn la zi ojum  ir glikozes m r t ja, og hidr tu un insul na 
dati par katru zi ojuma laikposma dienu. Taj  ir dienasgr mata ar 
katras stundas notikumiem, k  ar  dienas vid jie un kop jie r d t ji.
Katr  lap  ir l dz 14 dienu ieraksti. Ja zi ojuma laikposms ir ilg ks par 
14 dien m, tiks ener tas papildu lapas.

Ier ces iestat jumu momentuz mums        

Šaj  zi ojum  ir pacienta s k a vai Guardian REAL-Time monitora 
iestat jumu momentuz mumi konkr t  datum  un laik . Tas pal dz
saprast citus zi ojumus, k  ar  dokument  pacienta iestat jumus.

S k a un monitora iestat jumi tiek ierakst ti vien gi tad, kad ier ce tiek 
nolas ta. Ja ier ce nav nolas ta zi ojuma laikposm , neviens 
iestat jums neb s pieejams.

Detaliz ts dienas zi ojums        

Detaliz taj  dienas zi ojum  tiek par d ti glikozes dati, og hidr tu 
daudzums un pacienta insul na pat ri š izv l t  dien . Katrai datu 
tabul  izv l tai dienai tiek ener ts atseviš s zi ojums.

Detaliz tais dienas zi ojums sniedz detaliz tu ieskatu par katru 
izv l to dienu. T d  iesp jams koncentr ties uz konkr tu dienu, ja 
jums š iet, ka pacienta rst šan  noticis kaut kas iev r bas cien gs.

Datu eksport šana

Ieg tos ier ces datus var eksport t un uzglab t CareLink Pro. Tas auj 
izmantot visus pacienta ier ces datus statisktikas ieg šanai vai 
specifisku zi ojumu un diagrammu izveidošanai. .csv failu var import t
Microsoft Excel programm  vai atseviš s kl nisk s statistikas 
programm s, kur to var papildus apstr d t.

.csv faili satur datus, kuros ierakst tas ier ces darb bas. Piem ram,
tajos ir m r t ja r d jumu ieraksti, s k a ieraksti, kas sa em m r t ja 
r d jumu v rt bas, pamata truma izmai as.
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PIEZ ME: T  ir papildu
iesp ja, t d  jums

j paz st ier ces j ldati.
Šim nol kam

nepieciešama ar  to
programmu

p rzin šana, kur  tiek
import ts .csv fails.

Lai izmantotu CareLink Pro eksporta iesp ju, veiciet š dus so us:

1 Klikš iniet uz pacienta cilnes vai OPEN PATIENT pogas un veiciet 
dubultklikš i uz pacienta v rda.

2 P rliecinieties, ka tiek r d ta Reports darbtelpa.

3 Lai iestat tu datumus un zi ojuma laikposma ilgumu, lietojiet Duration
vai From/Through laukus.

Maksim lais ilgums, ko var izv l ties, ir 12 ned as.

4 Klikš iniet uz export selected data saites.

Par d s dialoga logs Export Data to CSV File.

5 Lai main tu vietu dator , kur saglab t .csv failu, klikš iniet uz bulti as
pa labi no  Save in lauka un izv lieties saglab šanas vietu.

6 Ja v laties main t faila nosaukumu, ierakstiet to File name lodzi .

7 Klikš iniet uz SAVE.

PIEZ ME: S k k par datu
par d šanu CSV failos

skat t CSV dati,
lappus 64.

Tagad .csv fails ir saglab ts j su dator  izv l taj  viet . To var 
import t cit s programm s, kas atbalsta šo faila veidu.

izv l to datu 
eksporta saite
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Sist mas administr šana 8
Kas ir šaj  noda
• Pirms s kšanas: lappuse 54
• Programmat ras jaunin jumu instal šana: lappuse 55
• Datub zes dubl šana un atjaunošana: lappuse 56

Ir svar gi regul ri veidot CareLink™ Pro datub zes dubl jumu. 
Datub z  glab jas visi sist mas dati, kas ir uzkr ti j su pacientu 
ierakstos, ietverot profila inform ciju, ier u datus un zi ojumu 
iestat jumus. 

CareLink Pro auj saglab t datub zes kopijas un atjaunot t s.

Svar gi ir ar  raudz ties, lai jums b tu jaun k  CareLink Pro versija. 
Atjaunin t s versijas ir pieejamas periodiski, un taj s var b t noz m gi 
uzlabojumi. J s varat pats mekl t jaunin jumus, bet varat izv l ties, lai 
par tiem tiek jums pazi ots.

Pirms s kšanas

Lietder gi ir izveidot grafiku, saska  ar kuru tiks veidoti datub zes 
dubl jumi. T  var iev rot regularit ti un samazin t datu zuduma risku. 

Dubl juma vai atjaunošanas laik  CareLink Pro identific  citus 
lietot jus, kas var tu lietot šo programmat ru savos datoros, un 
pied v  tiem iesp ju saglab t vi u darbus. Tom r lab ka prakse ir 
p rbaud t citu lietot ju esam bu pirms jebkura procesa s kšanas.
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Programmat ras jaunin jumu instal šana

Autom tiski sa emtie jaunin jumi

B s pieejami neregul ri CareLink Pro programmat ras jaunin jumi. 
Kad par d s pazi ojums par jaunin jumu, jaun k s programmat ras
versijas lejupl dei veiciet š dus so us.

PIEZ ME: Pirms
jaunin jums tiek

uzinstal ts, datub ze ir
j dubl . Skat t

Datub zes dubl šana,
lappus 56.

1 P rliecinieties, ka j su datoram ir savienojums ar internetu un tas ir akt vs.

2 Kad pieejams CareLink Pro jaunin jums, par d s pazi ojums
CareLink Pro Update. Tas pied v  jaunin jumu lejupl d šanas opciju.

3 Klikš iniet uz DOWNLOAD (Lejupl d t). (Ja uzklikš in siet uz 
CANCEL (Beigt), jaunin juma pazi ojums aizv rsies. Jaunin jumu
var s lejupl d t v l k).

Par d s br din juma pazi ojums, kas iesaka veikt datub zes 
dubl jumu.

4 Lai dubl tu datub zi, noklikš iniet uz YES (šo proced ru skat t
Datub zes dubl šana, lappus 56). Ja nev laties dubl t savus 
datus, klikš iniet uz NO.

Par d sies pazi ojums, kas apstiprin s, ka jaun  CareLink Pro versija 
ir lejupl d ta.

5 Lai s ktu lietot jaun ko CareLink Pro versiju, klikš iniet uz YES, lai 
aizv rtu un atkal atv rtu lietojumprogrammu. Ja nev laties uzreiz 
CareLink Pro restart šanu, klikš iniet uz NO.

Autom tisk s atjaunin šanas atsl gšana

Ja nev laties sa emt autom tiskos pazi ojumus par CareLink Pro 
jaunin jumiem, veiciet š dus so us:

1 Izv lieties Tools > Options.

2 Klikš iniet uz General cilnes.

3 Komunik ciju sada  atceliet atz mi blakus Automatically check for 
software updates.
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Manu la jaunin jumu p rbaude

Jebkur  laik  iesp jama manu la CareLink Pro jaunin jumu p rbaude.

PIEZ ME: Pirms
jaunin jums tiek

uzinstal ts, datub ze ir
j dubl . Skat t

Datub zes dubl šana,
lappus 56.

1 P rliecinieties, ka j su datoram ir savienojums ar internetu un tas ir 
akt vs.

2 Izv lieties Tools > Check for Software Updates

3 Ja pašreiz jaunin jumu nav, sa emsiet pazi ojumu. Ja ir pieejams 
jaunin jums, tiks par d ts CareLink Pro Update pazi ojums.

4 Izpildiet Autom tiski sa emtie jaunin jumi, lappus 55 instrukcijas.

Datub zes dubl šana un atjaunošana

Datub zes dubl šana     

Lai dubl tu pašreiz jo datub zi izv l taj  viet , veiciet š dus so us.

1 P rliecinieties, ka visi pacientu ieraksti ir aizv rti.

2 Izv lieties Tools > Backup Database (R ki > Dubl t datub zi).

PIEZ ME: Datub žu
dubl jumus var

saglab t uz t kla diska
vai r ja nes ja (DVD,

CD, USB dzi a u.c.).

3 Lai saglab tu dubl jumu cit  datora viet , klikš iniet uz bulti as pa 
labi no Save in lauka un izv lieties jaunu saglab šanas vietu.

4 Ja v laties main t dubl juma faila nosaukumu, ierakstiet to File name
lodzi .

5 Klikš iniet uz SAVE. Datub zes saglab šanas darb bas laik  par d s
procesa virz bas josla.

Kad dubl jums ir pabeigts, par d s pazi ojums.

6 Lai aizv rtu pazi ojumu, klikš iniet uz OK.

Datub zes atjaunošana        

Ja datub zei vairs nevar piek t vai to lietot, var b t nepieciešams to 
aizvietot.

UZMAN BU! Veicot atjaunošanu no dubl jumkopijas, tiks zaud ti visi jaun kie dati, kas tika 
izveidoti p c izv l t s dubl jumkopijas izgatavošanas.

Lai aizvietotu esošo datub zi ar dubl jumkopiju, veiciet š dus so us.

1 P rliecinieties, ka visi pacientu ieraksti ir aizv rti.

2 Izv lieties Tools > Restore Database.

3 Izv lieties dubl juma failu, kuru v laties izmantot pašreiz j s datub zes
aizvietošanai (parasti visjaun ko).

4 Klikš iniet uz OPEN. Par d s br din juma zi ojums. Klikš iniet uz OK.
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5 Datub zes atjaunošanas darb bas laik  par d s procesa virz bas josla.

Kad datub ze ir atjaunota, par d s pazi ojums.

6 Lai aizv rtu pazi ojumu, klikš iniet uz OK.

Ja sist ma nav pieejama                

Ja m inat iesl gt sist mu, kam r cits lietot js veic dubl šanu vai 
atjaunošanu, j s sa emsiet pazi ojumu par to, ka sist ma nav pieejama. 
Kam r šis uzdevums nav pabeigts, j s nevar siet piek t sist mai.

Veiciet vienu no š d m darb b m:

• Pagaidiet, kam r process tiek pabeigts un sist ma k st pieejama.
• Lai izietu un m in tu v l k v lreiz, klikš iniet uz CANCEL.
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Trauc jummekl šana 9
Kas ir šaj  noda
• Visp r jas lietojumprogrammas k das: lappuse 58
• Ier ces nolas jumu k das: lappuse 59
• Zi ojuma izveidošanas k das: lappuse 61
• Dubl juma un atjaunošanas k das: lappuse 62
• Programmat ras atinstal šana: lappuse 62

Š  noda a izveidota, lai pal dz tu atrisin t probl mas, kas rodas, lietojot 

CareLink™ Pro programmu. T  satur ar  instrukcijas CareLink Pro 
programmas atinstal šanai, ja nepieciešams.

Visp r jas lietojumprogrammas k das

Privil ijas lejupl d t programmat ras jaunin jumus internet

M inot lejupl d t programmat ras jaunin jumus internet , J s varat 
sa emt pazi ojumu, ka Jums nav privil iju to dar t. Lai lejupl d tu 
CareLink Pro programmat ras jaunin jumus, Jums j b t administratora 
privil ij m.

1 Aizveriet CareLink Pro lietojumprogrammu un restart jiet savu datoru. 

2 L dziet, lai k ds ar administratora privil ij m piesak s dator .

3 Izpildiet Programmat ras jaunin jumu instal šana, lappus 55
instrukcijas.
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Nav savienojuma ar datub zi

K das pazi ojums par to, ka nav savienojuma ar datub zi, noz m  vienu 
no š d m iesp j m:

• Datub ze ir p rvietota. Datub zei j atrodas turpat, kur t  atrad s
CareLink Pro programmat ras instal šanas laik . Ja t  ir p rvietota, 
t j atg d  atpaka  turpat, kur t  bija instal šanas laik .

• Nav savienojuma ar t kla disku, uz kura atrodas datub ze. Ja datub ze
atrodas uz t kla diska, t klam reiz m var b t probl mas, kas ne auj
piek t diskam. Sazinieties ar datoratbalsta departamentu, kas pal dz s
no jauna savienoties ar t kla disku, uz kura atrodas datub ze. 

Aizmirsta kl nikas parole darbam ar CareLink Pro

Ja neviens neatceras paroli, ar kuru J su kl nika piesak s CareLink Pro, 
tad j veic CareLink Pro programmat ras instal šana no jauna un 
jaunas datub zes izveidošana. Kad programmat ra b s instal ta no 
jauna, vairs nevar s piek t iepriekš j  datub z  saglab tajai pacienta 
inform cijai. Veicot instal šanu no jauna, saglab jiet izveidoto paroli 
biroj , lai nezaud tu turpm kos datus. 

Ier ces nolas jumu k das

Izlasiet ier ces k du Izskaidrojums

The selected serial port 
could not be opened. Another 
operation might be in progress 
on that port. Please wait until 
the port is available, or select 
another port. (Izv l to seri lo 
piesl gvietu nevar atv rt. Šaj
piesl gviet  var norit t cita 
darb ba. L dzu, uzgaidiet, 
kam r piesl gvieta atbr vojas 
vai mekl jiet citu piesl gvietu.)

L dzu, p rbaudiet, vai izv l to COM piesl gvietu 
neizmanto cita programma, vai izv lieties citu 
piesl gvietu. M iniet ats kn t izmantoto datoru, 
p c tam m iniet v lreiz veikt ier ces nolas šanu. 
Piesl gvietai pievienot  aparat ra (kabelis u.c.) 
var b t boj ta vai pati piesl gvieta var b t boj ta.
Pievienojiet aparat ru citai piesl gvietai un m iniet 
v lreiz nolas t ier ci, lai noteiktu probl mu. 

Auto Detect could not find the 
device on any available port. 
Please check the cable 
connection, device battery 
& status and try again, or 
try specifying a serial port. 
(Auto Detect nevar atrast 
ier ci nevien  piesl gviet .
L dzu, p rbaudiet kabe a
savienojumu, ier ces bateriju 
un statusu, tad m iniet 
v lreiz vai nor diet seri lo 
piesl gvietu.)

P rbaudiet kabe a un PC savienojumu, k  ar
p rbaudiet, vai baterijas statuss ir labs. Ja t  ir, 
m iniet Auto Detect izv les viet  nor d t PC 
seri lo piesl gvietu, kurai pievienot kabeli.
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Device not found at selected 
serial port. Please check the 
cable connection, device 
battery & status and try 
again, try selecting a different 
port, or try to Auto Detect the 
device. (Izv l taj  seri laj
piesl gviet  nevar atrast 
ier ci. L dzu, p rbaudiet 
kabe a savienojumu, ier ces
bateriju un statusu, un 
m iniet v lreiz, m iniet 
izv l ties citu piesl gvietu 
vai m iniet noteikt ier ci
ar Auto Detect.)

P rbaudiet kabe a un PC savienojumu, k  ar
p rbaudiet, vai baterijas statuss ir labs. Ja t  ir, 
m iniet izv l ties citu PC seri l s piesl gvietas 
numuru vai izv lieties Auto Detect opciju.

Unable to communicate with 
the device. Please ensure 
you’ve attached and selected 
the correct device, check the 
cable connection, device 
battery and status, and try 
again. (Nevar komunic ties
ar ier ci. L dzu, p rliecinieties, 
ka esat pievienojis un izv l jies 
pareizo ier ci, p rbaudiet 
kabe a savienojumu, ier ces
bateriju un t s statusu, un 
m iniet v lreiz.)

P rbaudiet visus ier ces nolas šanas iestat jumus, 
ieskaitot ier ces nosaukumu, seri lo numuru un 
savienojuma veidu. T pat p rbaudiet, vai ier ce,
kabelis un PC ir pareizi savienoti. P rbaudiet, vai 
ier ces baterijas un trauksmes sign la statuss ir 
k rt b . M iniet nolas t v lreiz.

Unexpected response… 
retrying (n%). 
(Negaid ta atbilde… 
atk rtots m in jums (n%).)

No ier ces nolas ta negaid ta v rt ba. 
Sist ma m in s komunic ties atk rtoti,
kam r komunik cija netiks atcelta vai izdosies.

The communication device 
was found, but the pump 
(<serial #>) is not responding. 
Please verify the pump’s 
serial number, place the pump 
closer to the communication 
device to minimize interference, 
check pump battery and 
status. (Komunik cijas ier ce 
atrasta, bet s knis (<serial #>) 
nerea . L dzu, p rbaudiet 
s k a seri lo numuru, 
novietojiet s kni tuv k
komunik cijas ier cei, lai 
mazin tu krop ojumus, 
p rbaudiet s k a bateriju 
un t s statusu.)

P rbaudiet, vai ievad ts pareizais s k a seri lais 
numurs. Ja nav, atk rtoti ievadiet pareizo seri lo 
numuru. Ja seri lais numurs ir pareizs, m iniet 
novietot s kni tuv k komunik cijas ier cei vai 
p rvietojiet komunik cijas ier ci un s kni t l k
prom no iesp jamiem trauc jumiem (piem ram,
cit m RF ier c m) vai p rbaudiet s k a bateriju 
un padeves statusu.

This pump is delivering 
a temp basal. Please cancel 
the temp basal or wait until 
it completes, and then try 
again. (Šis s knis padod 
slaic go pamata devu. 

L dzu, atceliet slaic go 
pamata devu vai pagaidiet, 
kam r t  tiek pabeigta, p c
tam m iniet v lreiz.)

S knis, kuru gribat nolas t, pašlaik padod slaic go 
pamata devu. Lai nolas tu s kni, pagaidiet, kam r
tiek pabeigta slaic g s pamata devas padošana, 
vai atceliet slaic go pamata devu un p c tam 
nolasiet s kni.

Izlasiet ier ces k du Izskaidrojums
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Zi ojuma izveidošanas k das

Daudz datu ierakstu ar vien du datumu

Ja t m paš m ier c m taj  paš  datum  un laik  eksist  vair ki 
ieraksti, sist ma uzskata, ka tas ir konflikts, kuru t  nevar atrisin t. 
Zi ojumos, kas izveidoti, izmantojot š s ier ces datus, da a datu, kas 
p rkl jas, tiks izlaista. 

Lai izlaistu p rkl juma datus, var m in t kori t zi ojuma laikposmu 
vai ar  iz emt ier ci no sist mas, p c tam to pievienot atpaka , lai izt r tu 
iepriekš jos r d jumus.

Sist ma ignor  datus

Ja ier ces laiks ir main ts t , ka tas rada datu p rkl jumus vai 
iztr kumus tr s stundas vai ilg k, sist ma šo datu da u neietver, 
veidojot zi ojumus.

This pump has active errors 
or alarms. Please clear the 
alarms and try again. (Šim 
s knim ir akt vas k das vai 
trauksmes sign li. L dzu, 
izt riet trauksmes sign lus 
un m iniet v lreiz.)

S knim ir akt vi trauksmes sign li, kas var trauc t
t  nolas šanu. Lai trauksmes sign lus izt r tu,
izlasiet trauksmes sign lu instrukcijas. Izt riet
trauksmes sign lus un m iniet s kni nolas t
v lreiz.

This pump is delivering 
a bolus. Please cancel 
the bolus or wait until it 
completes, and then try 
again. (Šis s knis padod 
bolus devu. L dzu, atceliet 
bolus devu vai pagaidiet, 
kam r t  tiek pabeigta, p c
tam m iniet v lreiz.)

S knis, kuru gribat nolas t, pašlaik padod bolus 
devu. Lai nolas tu s kni, pagaidiet, kam r tiek 
pabeigta bolus padošana, vai atceliet bolus devu 
un p c tam nolasiet s kni.

The device returned invalid 
entries; all data read will be 
discarded. (Ier ce atsaka 
neder gus ierakstus; visi datu 
nolas jumi tiks atmesti.)

Sazinieties ar viet jiem p rst vjiem
(skat t Pal dz ba, lappus 3).

Izlasiet ier ces k du Izskaidrojums
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Dubl juma un atjaunošanas k das

Datub zi nevar blo t

Tas noz m , ka j s izmantojat datub zi daudzlietot ju vid , kur  ir 
pieteikušies citi lietot ji. Sist ma ne aus veikt datub zes dubl šanu, 
kam r citi lietot ji, iesp jams, veic uzdevumus, kas var ietekm t
datub zi. Kad citi lietot ji ir izg juši no CareLink Pro, var izveidot 
datub zes dubl jumu.

Datub zes dubl jums vai atjaunošana nav pabeigta

Citi lietot ji nevar pieteikties un dubl jumu vai atjaunošanu nevar 
pabeigt. L dzu, sazinieties ar savu viet jo p rst vi (skat t Pal dz ba, 
lappus 3).

Datub zes atjaunošana neizdodas

Datub zes dubl juma fails, no kura j s m in t atjaunot b zi, ir boj ts. 
M iniet atjaunošanu no cita dubl juma faila.

Programmat ras atinstal šana

Ja nepieciešams atinstal t CareLink Pro, veiciet š dus so us:

1 Atveriet Control Panel sav  Windows Start izv ln .

2 Izv lieties Add or Remove Programs. Par d sies Windows 
programmu pievienošanas vai iz emšanas logs.

3 Ritiniet uz leju uz Medtronic Carelink Pro un uzklikš iniet uz t .

4 Klikš iniet uz REMOVE. Par d s InstallShield Wizard.

5 Klikš iniet uz NEXT. Par d s pazi ojums, kur  tiek l gts apstiprin t,
ka v laties iz emt lietojumprogrammu.

6 Klikš iniet uz YES. Notiek programmas atinstal šana, un no j su
datora tiek iz emta š  programma ar visiem t s failiem. Kad tas ir 
izdar ts, ved a ekr n  par d s pazi ojums, kas apstiprina atinstal šanu.

7 Klikš iniet uz FINISH.
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Ikonu tabula
Uz iepakojuma mar juma un aparat ras esoš s ikonas un simboli 
izskaidroti n kamaj  tabul :

Apraksts Ikona

Viena vien ba konteiner /iepakojum (1x)

Uzman bu: skat t lietošanas instrukcijas

CD iek auts

Svar gi dokumenti iek auti

Kataloga numurs REF

Atbild gas instit cijas CE mar jums 
medic niskai ier cei
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CSV dati A

Šaj  pielikum  ir aprakst ti CareLink™ Pro dati, kurus j s redzat, 
eksport jot CSV form t .

Slejas datu defin cijas

Slejas nosaukums Defin cija

R d t js Sec ba, k d  dati tika ierakst ti ier c .

Datums Datums, kur  dati tika ierakst ti ier c .

Laiks Laiks, kur  dati tika ierakst ti ier c .

Jauns ier ces laiks Jauns datums un laiks, ja tas ier c  ticis main ts.

BG r d jums 
(mg/dl vai mmol/l)

Asins glikozes r d jums, ko ierakst jis m r t js, 
Guardian vai s knis. Ja dati ir no s k a vai 
Guardian, šaj  slej  tiek atspogu oti manu li 
ievad ti BG vai BG, kas sa emti no Link m r t ja. 

Piesaist ta BG m r t ja ID M r t ja, kurš s ta konkr tu asins glikozes 
r d jumu uz ier ci, s rijas numurs.

Pamata trums (U/h) Akt vais pamata insul na padeves trums
vien b s/stund .

slaic g s pamata padeves 
daudzums 

Ja s knim izmanto slaic go pamata padevi, š
v rt ba ir slaic g s pamata padeves daudzums. 

slaic g s pamata padeves 
veids

slaic g  pamata padeves veida korekcija 
(insul na trums vai procenti no pamata truma).

slaic g s pamata padeves 
ilgums (m)

slaic g s pamata insul na padeves laiks min t s
(skat t veidu iepriekš).

Bolus devas veids Bolus insul na padeves veids [parastais, Square, 
Dual (parast  da a) vai Dual (kvadr ta da a)].

Izv l tais bolus devas 
tilpums (U)

Izv l tais insul na vien bu skaits, kas j ievada 
insul na bolus devas veid .

Padotais bolus devas 
tilpums (U)

Faktiski padotais insul na vien bu skaits, kas 
faktiski ievad ts insul na bolus devas veid .
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Ieprogramm tais bolus 
ievad šanas ilgums (h)

Square bolus vai Dual wave bolus kvadr ta da as
ievades ilgums.

Inici šanas veids

Manu ls vai fiks ts. Manu lais tiek lietots uzreiz 
p c p rt šanas, lai piepild tu insul na inf zijas
komplekta caurul tes ar insul nu pirms to 
ievad šanas. Fiks to izmanto p c tam, kad 
inf zijas komplekts ievietots, lai p c ievad šanas
adatas iz emšanas piepild tu m ksto kanulu ar 
insul nu. 

Padotais inici cijas devas 
tilpums (U)

Insul na vien bu skaits, kas faktiski tika izmantots 
inici šanai.

Trauksme Trauksmes sign la nosaukums.

Aptur t Identific  aptur ta s k a statusu.

P rt t Ier ces p rt šanas datums un laiks.

BWZ apr ins (U) Bolus insul na apr ins, ko veic ar Paradigm 
s k a Bolus Wizard opciju.

BWZ m r a augsts BG 
(mg/dl vai mmol/l)

Glikozes l me a asin s m r a diapazona augš j s
robežas iestat jums, ko lieto Bolus Wizard opcij .

BWZ m r a zems BG 
(mg/dl vai mmol/l)

Glikozes l me a asin s m r a diapazona 
apakš j s robežas iestat jums, ko lieto Bolus 
Wizard opcij .

BWZ og hidr tu da a

Insul na un og hidr tu attiec bas iestat jums. Ja k
vien bas izmanto gramus, attiec ba ir gramu skaits, 
ko no rda viena insul na vien ba. Ja k  vien bas 
izmanto apmai as, attiec ba ir insul na vien bu 
skaits, ko izlieto vienai apmai ai.

BWZ insul na jut ba
Insul na jut bas iestat jums. Insul na jut ba ir asins 
glikozes l me a lielums, ko samazina viena 
insul na vien ba. To izmanto Bolus Wizard opcija.

BWZ og hidr tu ievade Og hidr tu daudzums, kas ievad ts Bolus Wizard 
opcij  un ko lieto, lai apr in tu bolus.

BWZ BG ievade 
(mg/dl vai mmol/l)

Glikozes l me a asin s r d jums, kas ievad ts
Bolus Wizard opcij  un ko lieto, lai apr in tu
bolus.

BWZ korekcijas apr ins (U)
Bolus insul na vien bas, lai veiktu asins glikozes 
l me a korekcijas, kas apr in tas ar Bolus 
Wizard opciju.

BWZ p rtikas apr ins (U)
Bolus insul na vien bas, lai nor d tu paredz to
og hidr tu pat ri a daudzumu, kas apr in ts
ar Bolus Wizard opciju.

BWZ akt vais insul ns (U)

Apr in tais akt v  insul na daudzums, kas palicis 
organism  no iepriekš j m bolus insul na devu 
padev m, nosakot apr in to bolus daudzumu 
ar Bolus Wizard opciju.

Sensora kalibr cijas BG 
(mg/dl vai mmol/l)

BG v rt ba, ko izmanto sensora kalibr šanai
mg/dl vai mmol/l.

Sensora glikoze 
(mg/dl vai mmol/l) Sensora glikozes v rt ba.

ISIG v rt ba Ievades sign li (ISIG), ko nolasa no sensora un 
m ra nanoamp ros (nA).

Slejas nosaukums Defin cija
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Vair k par CSV failiem, ko eksport  CareLink Pro

Nosaukums CSV faila augšpus  ietver:

• pacienta v rdu
• izv l to ier u sarakstu un to seri los numurus
• izv l to datu diapazonu

Katram sleju blokam ir nosaukums, kas ietver:

• ier ces nosaukumu, kurai piem ro datu bloku
• š s ier ces seri lo numuru 

Ja dati netiek par d ti, k  paredz ts

Ir vair ki iemesli, k d  CSV dati tiek par d ti cit di nek  paredz ts:

• ier ces datuma vai laika mai a var main t r d šanas sec bu vai iznest 
ierakstus rpus izv l t  par d m  datumu diapazona.

• ja starp ier ces nolas jumiem ir liela atstarpe, š s ier ces dati var b t
par d ti vair kos blokos.
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V
rd

n
ca

V rdn ca

A
A/B modelis  Pamata modelis, kas atbalsta aktivit tes l me us, 
kas nav da a no j su ikdienas rut nas, bet ir norm la j su dz vesveida 
sast vda a. Š das aktivit tes var b t sporta nodarb bas, ko apmekl jat
reizi ned , vai gul šanas rež ma izmai as ned as nogal s, ilgstošos 
lielas vai mazas aktivit tes laikposmos vai menstru ciju laik .
A1c  Glikoz ts hemoglob ns
A1c tests  Hemoglob na A1c tests, ko izmanto, lai interpret tu glikozes 
l meni asin s laik  (dinamik ).
Aptur t S k a funkcija, ar kuru aptur insul na padevi. Visas 
notiekoš s un/vai inici još s padeves tiek atceltas. Pamata padeve 
tiek aptur ta l dz restart šanai.
Audio bolus  S kni var ieprogramm t t , ka tad, kad tiek izv l ts
bolus ievad m  insul na daudzums (piem ram, 0,5 vai 1,0 vien ba), 
lietot js sadzird p kstienu. Tas noder situ cij s, kad ir gr ti redz t
s k a pogas.

B
BG  Glikoze asin s
Bolus insul ns  Insul na deva, ko ievada, lai tas b tu pietiekam
daudzum , kad ir sagaid ma glikozes l me a celšan s asin s (piem ram, 
p c diena vai uzkodu pat ri a) vai kad j samazina augsts glikozes 
l menis asin s l dz m r a diapazonam.
Br din jums par rezervu ra iztukšošanos  Ieprogramm jams 
br din jums, kas zi o, kad s k a rezervu r  palicis noteikts skaits 
vien bu, vai noteikts laiks, p c kura rezervu rs b s tukšs.

C
Cal Reminder   Cal Reminder v rt ba ir laikposms pirms pašreiz j s
kalibr t s v rt bas der guma beig m, lai atg din tu lietot jam, ka b s
j veic kalibr cija, kad s knis raid s METER BG BY trauksmes sign lu.
Piem ram, ja Cal Reminder iestat ts uz div m stund m, METER BG 
BY trauksmes sign ls skan s 2 stundas pirms kalibr šanas laika.
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Carb ratio (og hidr tu da a)  Og hidr tu daudzums, ko no rda
1 insul na vien ba. (Skat t ar  exch ratio.)
Carb units  P rtikas ievade, izmantojot Bolus Wizard. Ievad tas
(og hidr ti) gramos vai apmain tas.

CareLink™ Person ls  Tiešsaistes pakalpojums, kas auj p rvald t
diab ta datus internet .

CareLink™ USB Ier ce, ko lieto, lai Medtronic Diabetes Paradigm 
s rijas insul na s kn  vai Guardian REAL-Time monitor  saglab tos 
datus augšupiel d tu CareLink™ programmat r , izmantojot j su
datora USB piesl gvietu.
CH  Og hidr ts
Com-Station  Ier ce, ko lieto, lai lejupl d tu MiniMed 508 s kni un 
p rs t tu treš s personas m r t ja datus uz datoru.
ComLink   Radiofrekven u (RF) uztv r js un raid t js, ko lieto, lai 
lejupl d tu Paradigm s k a vai Guardian REAL-Time CGM sist mas 
datus dator .

D
Dual Wave® bolus  Nekav joties pieg d jam s parast s bolus devas 
apvienojums ar Square Wave bolus devu. Square Wave da a tiek 
pieg d ta noteikt  laikposm  vienm r gi.

E
Easy Bolus™  Metode parast s bolus devas pieg dei, izmantojot 
s k a Easy Bolus pogu.
Exch ratio (apmai as da a) Insul na daudzums, kas nepieciešams, 
lai nodrošin tu vienu (1) og hidr tu apmai u. (Skat t ar  carb ratio.)
Express bolus  Metode jebkuras bolus devas pieg dei, izmantojot 
s k a Express Bolus pogu.

H
HbA1c  Glikoz ts hemoglob ns
HbA1c tests  Hemoglob na A1c tests, ko izmanto, lai interpret tu 
glikozes l me a vad bu asin s  vai vid jos l me us 2–3 m nešu 
laikposm .
High Glucose  S knis s t s trauksmes sign lu, ja sensors r d s, ka 
lietot ja sensora glikozes l menis ir virs š s v rt bas. Šo opciju var 
iesl gt vai izsl gt.
Hyperglycemic  Paaugstin ts glikozes l menis asin s, kas ir redzams, 
uzraugot glikozes l meni asin s, nov rojot vai nenov rojot vienu vai visus 
š dus simptomus: nelabums, vemšana, neskaidra redze, galvass pes, 
gremošanas trauc jumi, bieža liela apjoma urin šana, letar ija.
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Hypoglycemic  Zems glikozes l menis asin s, kas ir redzams, 
uzraugot glikozes l meni asin s, nov rojot vai nenov rojot vienu vai 
visus š dus simptomus: p rm r gs izsalkums, tr c šana vai krat šan s,
sv šana, “klejojoša” redze, skurbums, galvass pes, neskaidra runa, 
p kš as garast vok a mai as, person bas izmai as.

I
Inf zijas komplekts  Ier ce, ko lieto, lai ievad tu un nostiprin tu zem 
das kanulu, pieg d tu insul nu no s k a pa caurul t m l dz ievad šanas 

vietai.
Insul na jut gums  Daudzums mg/dl (vai mmol/l), par k du viena 
insul na vien ba samazina j su glikozes l meni asin s (AG). 
(Bolus Wizard dati).
Insul na koncentr cija  Insul na stiprums vai veids, ko rsts izrakst jis
lietot jam. Tas ietekm trumu, ar k du s knis pieg d  insul nu. Ja 
main s lietot ja insul na koncentr cija, s kn  j p rprogramm  pamata 
mode i, pamata maksim l s devas un bolus devas padeves trums.

K
Ketona tests  Ketons ir blakusprodukts, kas rodas, kad organisms 
ener ijas ieguvei spiests sadedzin t taukus nevis glikozi. T  var b t
paz me insul na tr kumam organism . Ketona test  nosaka asin s vai 
ur n  koncentr t  ketona daudzumu.
Korekcijas bolus  Insul na daudzums, kas nepieciešams, lai augsts 
asins glikozes l menis pazemin tos l dz m r a diapazonam.
Korekcijas bolus koeficients (Jut guma koeficients)  Par cik 
1,0 insul na vien ba pazemina j su glikozes l meni asin s. Šo koeficientu 
izmanto, lai apr in tu korekcijas bolus devu, kad cukura l menis 
asin s ir augsts.
(BG level) – (BG target) = X. 
X ÷ (korekcijas bolus koeficients) = 
korekcijas bolus devas lielums

L
Link  Lai iesl gtu un iestat tu m r t ja opciju, kas auj s knim
sa emt BG r d jumus no CONTOUR® LINK, OneTouch® UltraLink™

vai Paradigm Link® m r t ja.
Šo terminu šaj  sist m  lieto ar , run jot par teksta hipersait m. Ja uz 
t m uzklikš ina, nok st cit  sist mas viet  vai cit  interneta vietn .
Low Glucose S knis s t s trauksmes sign lu, ja sensors r d s, ka 
lietot ja sensora glikozes l menis ir zem š s v rt bas. Šo opciju var 
iesl gt vai izsl gt.
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M
Maks. pamata insul ns  Maksim lais insul na daudzums, ko s knis
pieg d  vien  reiz . (Iestata lietot js).
Maksim l  bolus  Maksim lais bolus insul na daudzums, ko s knis 
pieg d  vien  reiz . (Iestata lietot js).
Manu la bolus  Ja Bolus Wizard ir akt va, BOLUS MENU  š  ir izv les
opcija. Viena metode bolus ieprogramm šanai bez Bolus Wizard. 
M r t js  medic niska ier ce aptuvenai glikozes koncentr cijas 
noteikšanai asin s. Mazu asins pilienu novieto uz vienreiz lietojamas 
testa str meles, kuru m r t js nolasa un r d jumus izmanto asins 
glikozes l me a apr in šanai. P c tam m r t js par da l meni k
mg/dl vai mmol/l. 
M r t ja opcija  Opcija, kas auj s knim sa emt BG r d jumus no 
piesaist t  BG m r t ja.
μl mikrolitrs

P
Pamata trums  S k a iestat jums, kas nodrošina nep rtrauktu 
insul na inf ziju, lai notur tu stabilu glikozes l meni starp dienreiz m
un nakt . Pamata insul ns imit  insul na pieg di no aizku a dziedzera – 
tas nodrošina visu organismam nepieciešamo insul nu, kas nesaist s
ar p rtikas uz emšanu. 
Pamata insul ns  Atbilstoši s kn  iepriekš ieprogramm tam profilam un 
individu li izv l tam trumam insul na s knis katru stundu autom tiski
veic nep rtrauktu insul na inf ziju. S knis pieg d  insul na dienas 
devu, kas parasti atbilst “fona” insul na pat ri am ne šanas laik
(proti, nakt  un starp dienreiz m).
Pamata mode i Lietot js s kn  var ieprogramm t l dz trim daž diem
pamata insul na pieg des truma mode iem: standarta, A un B. Katr
model  iesp jams iestat t l dz 48 pamata trumiem.
Pamata profils  Pamata trums ar s kuma un beigu laiku. Lietot js 
s kn  var ieprogramm t vair kus daž dus profilus, katru ar atš ir gu 
pamata trumu, lai 24 stundu laikposm  nodrošin tu lab ku glikozes 
l me a vad bu.
Parast  bolus  T l t ja noteikta insul na daudzuma padeve. 
P rtikas bolus  Insul na deva, kas nepieciešama, lai kompens tu 
sagaid mu glikozes l me a celšanos, kas notiek p c šanas.

R
RF  Radiofrekvence (RF). 
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S
Solis  J su iestat tais un ar Easy Bolus metodi pieg d tais insul na 
pieaugums.
Square Wave da a (Sq) Dual Wave bolus devas otr  da a. Square 
Wave da a tiek pieg d ta vienm r gi noteikt  laikposm  p c tam, kad 
ir pieg d ta NOW da a.

Square Wave® bolus  Bolus deva, ko pieg d  vienm r gi lietot ja
noteikt  laikposm  (no 30 min t m l dz 8 stund m). 
Standarta modelis  Parastais pamata modelis, kas atbilst j su 
ikdienas aktivit t m. Ja mode u opcija ir izsl gta, s knis darbojas 
p c j su standarta (pamata) mode a.

T
Temp  slaic gs
Temp basal (tmp basal)  slaic ga vienreiz ja pamata insul na pieg de 
noteikt  daudzum  un ilgum . Izmanto, lai atbalst tu nepieciešam bu 
p c insul na pašu aktivit šu vai apst k u gad jumos, kas neietilpst 
parast  ikdienas k rt b .
Transmtr ID  Pašreiz lietot  raid t ja s rijas numurs.

U
Upload  Process s k a vai m r t ja datu p rraid šanai uz CareLink™

Person ls serveri.

V
Vid jais zeml knes laukums (AUC)  Vid jais hiperglik mijas vai 
hipoglik mijas iedarb bas vid jais apjoms sensora p rraides laik .
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